
Prepress Glossary





White Book Series

Prepress Glossary

Walton Mendelson

February, 2017
One-Off Press



Copyright © 2012 Walton Mendelson
All images in this book are copyrighted by the author or by their respective authors, as noted.

All rights reserved.

walton@12on14.us

ISBN 978-0-615-59159-9

PhotoShop, Illustrator, and Acrobat are registered trademarks of Adobe. CreateSpace is a registered trademark of 
Amazon. All trademarks, these and any others mentioned in the text are the property of their respective owners. This 
book and One-Off Press are independent of any product, vendor, company, or person mentioned in this book. No 
product, company, or person mentioned or quoted in this book has in any way, either explicitly or implicitly endorsed, 
authorized or sponsored this book.

Special references have been made to CreateSpace (CS). These have been indicated textually and by 
boxing notes in gray. The concepts described are, in all other respects, applicable to other printers.



Prepress Glossary



The Prepress Glossary is designed to help understand what is necessary to produce books, with 
emphasis on images and working with digital presses. References to CS (CreateSpace, a print-on-
demand company) are included because the initial audience for this book is CS members. If you 
are working with a specific printer, consult them concerning particular requirements.

Sections on one topic, e.g. Paper, that are one or more pages are also on a gray background.
Bold words within a definition are reference to related entries.
Many words have meanings unrelated to prepress work—no attempt has been made to indi-

cate them.
It is not as important that you know the words as it is you know the ideas. This is not a sub-

stitute for manuals on Photoshop, PaintshopPro, etc. Katrin Eismann’s books on Photoshop are 
particularly good.

For a more complete glossary of printing terms see: http://www.printwiki.org. For more in-
formation about color and prepress techniques, Dan Margulis’s books and columns are all great.

If I have misstated or overlooked anything, please let me know: walton@12on14.us

Walton Mendelson 
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Glossary
1-bit color: A bit is either on or off, when it describes color it can represent only two colors (21). 

Although it could be any two colors, generally it is assumed to mean black and white. 

8-bit color: Eight bits offers 256 combinations, 28, thus when it is used to for color, it can 
represent 256 different colors. These could be 256 different colors, such as a VGA, or 
indexed color; or it could be monochrome.  

24-bit color: Twenty-four bits offers 16,777,216 possibilities. In RGB, if the red, green, and 
blue channels each are 8-bit, then the total number of colors is 256 x 256 x 256, or 16+ 
million colors. 

Absorbency: Also ink absorbency, is the paper characteristic that relates to how much ink is 
absorbed by paper. Too much absorbency can effect how ink that would normally air 
dry dries; it can result in dot gain; and it can result in a lack of gloss.  It is the opposite 
of holdout. 

Achromat: A camera or enlarging lens that has been modified to eliminate or reduce blurring 
(chromatic aberration) due to focusing on only one color. Most cameras today have 
achromat lenses, also called apochromatic.

Acid-free paper: A paper with either a neutral or basic pH (≥ 7). Acid in the paper breaks the 
long molecular chains that make up paper: causing embrittlement and yellowing. Acid 
comes from environmental sources as well as, and more commonly, the paper itself. 
Generally, museum grade, 100% rag, is made with cotton fibers. Conservation grade, 
acid free, is a buffered paper made with wood-based pulp, but is lignin and sulfur free. 
Often buffers are added to the paper to counteract any formation of acid that might start 
to occur. 

Additive color: Colors produced by adding colors together: RGB color space. These are red, 
green, and blue, such as your monitor, scanner, or camera. See subtractive color, CMYK.

Addressable resolution: see resolution

Adobe Acrobat Distiller: Originally, a program used to produce high quality PDFs for print. It 
is no longer the only way to created print-ready PDFs. Related to it, is the Adobe PDF 
virtual print driver, which produces PDFs from nearly any application.   

Aliasing: a distortion of the original image when it is reconstructed on screen or in print. Two 
common forms are jaggies and Moiré patterns.

Ambient light: the light surrounding an object or area. It effects how we see the color of things.

Analog proofing: a physical (e.g. printed) proof as opposed to a digital proof (e.g. a PDF) .
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Anti-aliasing: is a method intended to minimize aliasing, see jaggies.

Aritfact: a defect in a digital images. It can be caused by hardware or software. See aliasing.

Banding: a defect where a gradient seems to be posterized—having 
perceptible steps or streaks. Here the banding is on top and a 
smooth gradient below. It can be caused by a variety of things,
although the most common cause is a gradient that is either too long or does not have 
enough difference between either end.

Banding streaks: these are streaks in the printing. They can be caused 
by a variety of things, but generally they are a result of mainte-
nance or setup problems on the press. In digital printing, colors
made up of two or more process colors with a TIC of under 30% are suspectable to 
banding streaks.

Barcode: The barcode is derived from the ISBN, which 
every book must have. Free barcode generator: 
www.terryburton.co.uk/barcodewriter/genera-
tor/ or www.barcoding.com/upc/. General in-
formation: www.ggbarcode.com/ISBNinfor-
mationPage.html; color: www.barcode-us.com/
upc/upcColorChart.html The price code can be 
9000, which means no suggested price. Seew-
ww.barcode-us.com/upc/upcColorChart.html

CS Guidelines: “. . . our system will place your ISBN barcode 
in a 2” by 1.2” white box in the lower right-hand corner of your 
book’s back cover. . . . Images or text in the barcode location 
will be covered when the book is printed. . . . If you choose to 
provide and place your own barcode, be sure it is a high-reso-
lution image.”

Baseline: in typography this is the line on which most letters sit and below which descenders and 
some text figures (non-lining, old-style) extend. See Typeface Glossary.

Basis weight: the weight of one ream (500 sheets) of paper in pounds. In the metric system it 
would measured as grammage: grams /square meter (g/m2). Card stock is measure by 
thickness. See Paper.

CS uses 60lb offset text; covers are 10 pt cover stock.

Bézier curve: is a smooth, mathematically defined curve. It is controlled by creating control 
points and handles with when moved create the curve. It is common in most graphics 
programs, often called the pen tool. It is at the heart of vector graphics.
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Bit depth: A bit is the smallest amount of computer information: it’s a switch that is either on or 
off. Bit depth refers to how many bits that can be captured or displayed. A 1-bit image 
is has only two colors, black and white. An 8-bit image is 256 colors (a grayscale, for 
example. In RGB, there are three channels, typically 3 8-bit images/grayscales (one for 
the red, one for the green, one for the blue), would have 256 x 256 x 256 colors, 16+ 
million colors.

Bitmap: 1) also known as raster, if an image files where the image is composed of pixels and each 
pixel not only carries a discrete color but it’s location is precisely mapped. 2) Photoshop 
refers to pure black and white images as bitmaps. 3) BMP image format is called bitmap.

Black plate: also black printer, carries the black of a CMYK separation. Aside from carrying 
black image formation, it is used to enhance contrast and depth.

Bleeds: an image or background that runs to the very edge of a trimmed page, is said to bleed. 
It may bleed on one or more edges. To do this, the actual image or background must 
extend beyond the trim line so that when the page is trimmed it appears to bleed off the 
page. Most printers use a 0.125” bleed area. A 2-page image is said to bleed across the 
spine or inner margins. The gray tabs and bar at the top of this page bleed.

Book block: either all of the pages and/or signatures of a book gathered prior to binding, or the 
print-ready file of the complete book, not including the cover.

Bounding Box: is the minimum rectangular area that includes all of an ob-
ject. It can surround an image, shape, or text; and it can be dragged to 
move, transformed, rotated, or scaled. It is often referred to as a BBox. 
PDF’s have five different types of boxes:
•	 MediaBox—all PDFs have a MediaBox, which defines the maxi-

mum size of the page: trim size plus bleed, crop marks, if used, etc.
It is the largest box.

Note: CS does not want crop or other printer’s marks, con-
sequently, for CS, the media box is the same size as the trim 
size.

•	 CropBox—is the actual page size, most often used for monitor and printing. It is not 
very important in prepress work.

•	 BleedBox—by default it is the CropBox size. It is not used often.
•	 TrimBox—defines the dimensions of the finished pages.
•	 ArtBox—defines a region within a page.
Today these are less important than they were. They come up, for example, when open-
ing a PDF page in Photoshop, and with certain PDF issues.

Brightness: is an attribute of what we see in which the object appears to emit more (brighter) 
or less (less bright) light.
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                              Less bright                         Normal                             Brighter

Burn: see Dodging and Burning

Byte: A standard digital unit comprised of 8 bit. In bitmapped or raster art, each pixel is gener-
ally defined by one byte. 8 bits, 1 byte, equals 256 steps from white to black.

Calibration: Adjusting a monitor or scanner so that the images that are seen or produced will 
print accurately; and because light sources change with use their regular recalibration.

Camera ready: In prepress, art (images and text) that is ready to be photographed and turned 
into film, then plates, to be printed from. See print ready.

Channels: Digital images are made up of combinations of primary colors, and each primary 
color is a channel. Each channel is, in fact, a 256 step grayscale image that represents 
the color intensity information for a specific primary. There are additional channels for 
transparency, paths, etc. See color channels.

Choke: A trapping technique, where one color is made smaller. See Trapping.

Chroma: 1) similar to, or even synonymous with hue, depending on how it is used. 2) “Chroma 
is the colorfulness relative to the brightness of another color which appears white under 
similar viewing conditions.”* 3) In painting, generally, it means the purity of the color.

Clip: To cut, as when out-of-gamut color are simply cut off to the borders of the color space.

Clipping path: A vector shape or path used as a mask to cut out pixels Anything inside the path 
will be included (inclusive) after the clipping path is applied; anything outside the path 
(exclusive) will be omitted from the output. See mask

Cloning: In graphics programs the process of duplicating a source image area to a target area. 
Although these could be separate images, usually it is a way to duplicating, for example, 
little bits of background to remove a blemish (say a tear in a scanned image).

CMYK: a color model made of four colors: cyan, magenta, yellow, and black. It is used as the 
basic color model for most full color printing. In theory, CMY should produce black, but

* From <http://en.wikipedia.org/wiki/Saturation_(color_theory)> 05.07.11
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in practice it produces a weak black at best, but by adding black, 
not only is the black improved, but the black plate adds intensity, 
detail, and depth. See RGB.

Coated Paper: although commonly it mean a smooth, clay-coated paper, 
it actually means any paper with some type of coating that permits 
better printing. Usually coated papers are classified by the type of 
coating, such as clay coated. 

Color: is the visual perceptual property for what we call red, orange, yellow, green, blue, indigo, 
violet, etc. It is perceptual because it is not an objective description. There are three at-
tributes of color: Hue, saturation, and lightness. Additional descriptors: colorfulness, 
chroma, and brightness.

Color Channels: these are grayscales of the actaul pixels that make up each of the primary 
colors of color images (RGB or CMYK). In CMYK, they are not the same as the color 
separations from which the color piece is printed. 

Grand Tetons Barns, the John Moulton Barn, by Jon Sullivan, from Wikipedia. < http://
en.wikipedia.org/wiki/File:Barns_grand_tetons.jpg> 04.22.11

Color balance: the extent to which an image appears to have neutral lighting—the presence or 
absence of a color cast. 

Color calibration: to fix, correct, or adjust the color on a monitor or scanner. 

Color Cast: an overall tinge of color, generally unwanted, in a printed piece or photograph. 

Color control strip: a series of color bars printed on the press sheet used to control the printing.
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Color
CS is set up to print best from sRGB,* a specific kind of RGB (red, green, blue), which is the 

universal color mode used by consumer cameras, scanners, monitors, TVs, and most graphics 
programs. For most people, simply using the color images they have or create is all that they need 
to do. However, there can be significant differences between RGB and CMYK (cyan, magenta, 
yellow, black), which is used by most printers to print full color.

Is this RGB to CMYK conversion an issue? Here, I do not think it is:

This is a screen shot† of the original RGB image on the left and the CMYK conversion on the 
right. Whereas, large, solid areas of bright colors like these do not convert well:

* If color corrections are made to the CMYK art, or if all the color is in-gamut, then CS prints equally well 
from CMYK files. 	

† Often the only way to show the relative color values is a side-by-side screen shot. 	
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Although the montage of images above did not seem hurt by the conversion to CMYK, other 
images could have been: as much as the color blocks and ramp were!

To explain some of this, we need to look at color.space: 

(White box is RGB. Black box is CMYK. Inside a box is in-gamut; outside is out-of-gamut.) 
The eye sees light, so if you’re asking what happened to black, it is the absence of light. In 

the upper left is a common schematic of all visible colors. What can be represented by RGB is 
outlined in white; and what can be represented by CMYK is outlined in black. Each outlined areas 
represents a color space, often called a footprint or a gamut. Colors contained within a particular 
outline are in-gamut, and colors that are outside that outlines are out-of-gamut: that is, they do 
not exist in the color space.
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The secondary colors of RGB (those made up of equal parts of any two primary colors) are 
cyan, magenta, and yellow, just a little brighter and more vibrant than their primary counterparts 
in CMYK. And the secondary colors in CMY (those made up of equal parts of any two primary 
colors) are red, green, and blue, just a little duller and less vibrant than their primary counterparts 
in RGB.

The catch to all this is that:
•	 these illustrations presume pure color, pure white light, etc.—things that do not exist in practice;
•	 we are using multiple conversions to just discuss this:

•	 the sRGB image was adjusted by the profile in my monitor and through Photoshop
•	 the conversion to CMYK was created by Photoshop but is then converted to RGB to be 

seen on the monitor
•	 I took a screen shot of the RGB and CMYK versions, in sRGB
•	 CS will convert these to CMYK to print them.
And there is a final bit of magic to what printers do. It’s not just that CMYK are the four colors 

used to represent the world of color, but it is done with halftone screens:

Color can be very accurately measured. That is important for printers to be able to adjust the 
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process colors (cyan, magenta, and black); but for most of us, what we want is the overall color 
to look right. If some of the colors get compressed or slightly shifted to create the perception that 
the color is all there, we don’t care—but a spectrophotometer would care.

Finally, one more bit of mischief: our brains. It’s not just whether we are in some degree 
color blind, but how do people see in general.

Due to something called simultaneous contrast we perceive two greens on the left had graphic, 
and on the grayscale version of it, we perceive two different grays in the same relative place as the 
greens were. Three colors in one, and three grays in the other. Our brains manufacture the fourth.

Working with CS

As a practical matter, CS is set up to accept RGB work (sRGB is best, and most common form 
of RGB). Most images will print well with CS’s stronger cyan and redder magenta.

Print out all or at least several images: your desktop printer is CMYK, you’ll get a reasonable 
feel for CMYK conversions and the lightness/darkness of your image.*

If you use large solid areas of bright color, try to anticipate problems: avoid deeply saturated and 
bright colors.

Highlight detail tends to burn out and shadow detail tends to plug up—try to open of shadow 
details and enhance highlight detail.

If you’ve got what should be pure white and pure black in your image, try to set those points—do 
not bring them in 5-10 points from each end, a common practice that muddies images.

If you are in doubt about how your images will print, make a test book. Use a throw-away title, free 
ISBN, 24 pages, label every image if you try different ways to prepare them for print—$10 
and you’ll have an answer in a week.

If you plan to print with a different printer, ask them about profiles, color modes, PDF presets, etc.

* Most monitors are not well calibrated if at all: they often have shifts in color and are usually way too 
bright.	
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Color correction: The process of adjusting colors in an images because of a defect in the origi-
nal art, to enhance the image, or to prepare the image for printing.

Colorfulness: is the difference between a color set against gray.

Color management: generally the use of some kind of software or hardware intended to make 
color match between two different kinds of devices; for example, between the monitor 
(RGB) and the printer (CMYK). It is vital at the system level (operating system, video 
card, etc.). It can help in soft proofing. How effective color management can be is debat-
able, especially if the calibration is not correct.

CS does not make make known it’s profile or any other rel-
evant printing information.*

Color model (mode): is a system for describing color. Most importantly to this book are RGB 
(Red, Green, and Blue transmitted light, additive (all light is white, no light is black), 
and CMYK (Cyan, Magenta, Yellow, and Black, ink on paper, reflective light, subtrac-
tive (all color is black, no color is white). See CMYK, Lab, RGB, Grayscale.

Color Profile: profiles are look-up tables that describe a specific color space. If your monitor 
profile is entered into Photoshop and my monitor profile is entered into Photoshop, we 
will probably see the same color if we enter, for example, it’s RGB value.

In the context of color books printed by CS, I found that the 
whatever color profiles CS uses to print (CMYK screened on 
paper) from sRGB images (input, PDF) produces images that 
seem to perceptually match nearly perfectly: however, we do 
not know what those profiles are.

ICC Profiles are standards for color characteristics for input and output devices established 
by the International Color Consortium.

Color separation: separating and image or file into its CMYK components. This can be digital 
or film. See color channels and screen.

Color Space: can be general as in CMYK, RGB, LAB, or device specific a Sony Trinitron moni-
tor, an Epson 7600 Ultrachrome printer. A specific color space can be referred to as the 
gamut or footprint. Simplistically, all CMYK color is contained in RGB, but not all RGB 
colors exist in CMYK. See out-of-gamut, CMYK, Lab, RGB, Grayscale.

Color Spectrum Wedge: see step wedge.

*	 I believe that CS uses Indigo presses. A 2009 press release connects Amazon, BookSurge (the precursor 
to CS) and the Indigo 5000 series presses. Amazon purchased BookSurge, in Charleston, SC, 2005, 
the same year it purchased CustomFlix (an on-demand video company), later renamed CreateSpace. 
Several companies have referred to Amazon using Inigo presses, including HP Indigo.
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Compression: is a process designed to reduce a file’s size. Very generally, this can be done by 
removing statistical redundancies, where no data is lost (lossless), or removing margin-
ally important information (lossy). See jpg, lossless, lossy.

Continuous tone: images that contain continuous gradations of shade and hue (e.g.photographs 
and paintings). These have to be converted into halftone screens (or the equivalent) for 
commercial offset printing. Sometimes called contone. See halftone, line art.

Contact Proof: a proof made directly from the film.

Contract proof: is a color proof (or grayscale for grayscale work) that is itself viewed as a con-
tract between printer and client as the final proof. This may be a laminate proof such as 
a Matchprint or Chromalin, or a press proof.

CS (as well as other p-o-d printers) supplies a printed, bound, 
and trimmed copy of the book itself as a proof. Not only does 
it give the author or publisher a chance to look for problems 
and correct them, it represents how the book will look printed 
from the submitted files.

Contrast: the amount of gradation between tones.

                                Less contrast                           Normal                            More contrast

Cover stock: heavy paper (card) used for the covers of paperbacks, brochures, etc.

Curves: remap tonal values for image enhancement. Generally “curves” implies a Photoshop 
feature, or the equivalent in other graphics programs.

Delta E: the term used to describe color differences. Specifically, it was developed to work in 
LAB color space. Ideally, it would provide a quantifiable number that would enable 
defining how much variation in color printing is or is not acceptable. See simultaneous 
contrast.

Densitometer: a device that measures reflected or transmitted light for measuring the optical 
density of colors. It is used to help maintain consistency in a print run.

Desaturate: is to remove or decrease color value, by adding white, gray, or black. See saturation.
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Device Gray: The process color mode for black and white digital files that relies on the color 
profile of the device, to be processed—in the context of prepress, that is the printing 
press.

Device resolution: A device is any piece of hardware added to a computer; and device resolu-
tion is the resolution of an output device, such as a monitor or printer. See resolution.

Digital printing: Is not photomechanical; the color is separated into CMYK digitally. The
most common digital printing is inkjet and laser printers. How-
ever, HP’s Indigo press, for example, is digital in that it gener-
ates an image or image separation digitally, but the printing pro-
cess is offset: the image/separation is created electrostatically 
(with the corona wires) on a plate cylinder that picks up the ink, 
one color per pass; the image is transferred to a blanket cylinder; 
and that transfers to the paper, which is being carried through 
the print engine by the impression cylinder.

Digital proof: A proof created from a digital file using inkjet, laserjet, etc. It is intended to 
produce an approximation of what the printed piece will look like. It can also mean an 
on-screen (monitor) proof. See analog proof, contract proof, soft proof.

Dodging and burning: In photography, dodging shields selected areas from light during print-
ing, resulting in lighter tonalities, and burning exposes selected areas to additional light 
during printing, resulting in darker tonalities. Photoshop and other graphics programs 
use these terms for tools the selectively lighten or darken areas.

Dot gain: The physical gain is size of a dot when ink is ap-
plied to paper caused by the ink sinking into the fi-
bers of the paper and spreading out. When the half-
tone dots increase in size, the image will look darker 
and softer. The dot pattern on the right has about a 
20% dot gain. Establishing the dot gain and com-
pensating for it permits better printing. The Photoshop default is a 20% dot gain, which 
is appropriate for most offset printing; however, Indigo digital presses have a dot gain 
of 9-12%. See Ghosting.

Downsize: When an image’s resolution is reduced, e.g. 300dpi to 200dpi, that is called downsiz-
ing.

Some versions of Word will downsize images unless the file 
is set not to prior to inserting the images. (2010: Options > 
Advanced > Image Size and Quality > Do not compress im-
ages in file. 2007: Tools> Compress Pictures > Options . . . 
Untick “Automatically Perform Basic Compression”) Word 
calls this “compression,” but it is actually downsizing; Word’s 
Save As PDF feature also downsizes images).
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DPI: Dots per inch. Generally and incorrectly, this refers to the resolution of an image, which 
should be pixels per inch (ppi). The dpi of a printer, dpi, is the number of droplets of ink 
that can be controlled, or addressed. For example, the Pixma 882 inkjet has 9600 dpi x 
2400 dpi addressable dots, so a single color pixel at 300 ppi could have up to 256 dots 
of ink. See Resolution.

Drop shadow: see Transparency > Drop shdow.

Embed: See Font Embedding.

Eps: Encapsulated PostScript. A graphics file format based on PostScript. When an EPS file 
containing vector graphics is opened in a program like Photoshop, it is rasterizes the 
vector graphics to pixels. It does not support alpha channels.

Faux font: Each font is a complete set of characters of one species (regular, or italic, or bold, 
etc.) of a typeface. Most word processors can produce bold, italic, and bold italic even 
if you do not have those fonts.

True italic: abcdefghijklmnopqrstuvwxyz
Faux italic: abcdefghijklmnopqrstuvwxyz
Regular: abcdefghijklmnopqrstuvwxyz

In most word processors, a faux font is designated as real 
font, e.g. Bembo Italics, when there is no Bembo Italics, but 
a word was slanted to create the effect. When this is to be 
printed, a commercial press will look for Bembo Italics and 
not find it (it was not embedded), thus causing problems. 
However, Bembo Regular could be slanted, e.g. in Indesign, 
instructing the program to slant a word, and that could be 
printed because it was not been labeled italic.

Flatten: In files with multiple layers, merging all visible layers into one layer and, generally, discarding 
invisible layers. Converting an image to JPG, for example, flattens an image. Flattening an 
image makes editing it difficult—after saving and closing, flattening cannot be reversed—so 
a good workflow is to flatten a copy of a multi-layered file. Flattening may remove transpar-
ency, depending on the graphics program and how it is done. See Layers, Transparency.

Font: Originally, with metal type, a font was a specific typeface from a type family, in one size 
only. Today, font is synonymous with typeface.

Font embedding: To include the font, either in its entirety or as a subset of only the glyphs used, 
in a document. This enables the recipient of the document to view, print or edit it with 
the original font(s), even if they are not on the recipient’s computer. There are four main 
levels of font embedding (which were defined in the font itself when it was created): 1) 
Print and preview: fonts can be embedded however, the recipient cannot edit the con-
tent. 2) Editable: fonts can be embedded and the recipient can edit the document, but 



Image File Formats
Most graphics programs have their own, native file formats: Photoshop—PSD, GIMP—XCF, 

PaintShop Pro—PSP, etc. These hold things that are unique to each program. Camera raw files—im-
age files that have minimally processed data—are often in native file formats unique to a specific 
brand of camera, Olympus—ORF, Nikon—NEF, Canon—CR2, etc. While useful within specific 
applications, image files in these formats must be changed to be accessible in other applications 
or more general use.

Image files are of two general type, lossless, where no image data is lost, and lossee, where 
some image data is lost. The most common image format is JPG, which is lossee, and TIFF, which 
is lossless. As noted under JPG, with maximum quality (85-100% or 10-12 on Adobe’s scale) 
image degradation is virtually nonexistent, unless the images is opened/saved/closed many times.

PDF’s hold images as JPGs or TIFFs. Acrobat gives you the choice, most other common 
conversion programs do not. To put file size and print quality into perspective, for a recent job 
I did an image with a 1.7 GB size (300 dpi, multiple layers, approximately 12 x 20 inches), but 
the finished, print-ready file, JPG was 13.9 MB, and if the overall file size for the book had been 
a problem that could have been reduced to 3 MB with negligible effect. Why use the larger JPG: 
because size was not a problem and I did not want even a negligible loss, let alone the possibility 
of loosing more—a 46 MB TIFF file was absolutely unnecessary for a halftone image.

A sample 5 x 8 inch image at 300 dpi saved in different file formats:

Format Compression Color Mode File size
TIFF — CMYK 14.6 MB Lossless
PSD—Photoshop — CMYK 13.6 MB Lossless
TIFF — RGB 10.6 MB Lossless
PSD—Photoshop — RGB 10.6 MB Lossless
XCF—GIMP — RGB 10.6 MB Lossless
PSP—PaintShopPro — RGB 7.9 MB Lossless
JPG` 100% / 12 CMYK 6.5 MB Lossee
JPG 92% / 11 CMYK 4.3 MB Lossee
JPG 100% / 12 RGB 3.2 MB Lossee
JPG 83% / 10 CMYK 3.1 MB Lossee
JPG 92% / 11 RGB 1.8 MB Lossee
JPG 83% / 10 RGB 1.3 MB Lossee

Working with CS
Except for art prints, specialty printing, etc.—things where higher resolution and greater image 

information is essential: not things CS does—300 dpi images saved as JPGs at maximum quality/
minimum compression are adequate, and little if anything is gained above that. 
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the fonts cannot be installed permanently on his computer. 3) Installable: fonts within a 
document can be installed by the recipient, for editing the document or permanently. 4) 
No embedding: these fonts cannot be embedded. Most printers require that all fonts be 
embedded (completely or subsetted) in the PDF.

Format: In typography, the combination of type (size, typeface etc), line length, placement, 
letter and word spacing, etc., that produces the specific look of a page, or any part of a 
page. In computers, format refers to the type of file used for a document or image, or the 
preparation of a storage device to receive data.

Four color printing: Means CMYK printing.

Full Color: In reproducing an image or a scene, it is means that all colors in that scene or im-
age are represented. In the context of most printing, this is done by using CMYK with 
halftone screen separations. RGB is used in monitors, cameras, scanners.

Ghosting: artifacts that appear when a solid or screened image is interrupted by the uneven 
distribution of ink. This is mechanical ghosting. Another form of ghosting is optical.

        Mechanical                                                                           Optical
  (darker orange)                                                                           (light gray spots)

Optical ghosting can also be called optical dot gain. There are other forms of ghosting, 
for example, show-through caused by the volatiles in the ink being trapped by an over-
coat of varnish, changing the opacity of the paper.

Gamut: Refers to all the colors in a specific color space or output device (for example, print-
er or monitor) that can be represented. A specific color may be in-gamut (includ-
ed in the color space) or it could be out-of-gamut (excluded from the color space).

Glyph: A visual symbol of a letter, character, or symbol in a specific font.

Gradient: See Vignette

Grayscale: An image in which each pixel carries only an intensity or luminance value, no color 
information. Also known as black and white, or monochrome .

GCR: Gray Component Replacement. In CMY, any two colors produce another color, introduc-
ing the third color has the effect of graying the color (gray component)—changing the 
saturation. However, since that third color is a color, it introduces a cast. To more ef-
fectively change the saturation without altering the color is to substitute some Black for 
all or some of the third color. This helps increase shadow detail. Different inksets and 
profiles will have different GCR settings.
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Grayscale
Here is a pure grayscale, from 0-255 steps (256 bits), 256 steps from pure white to pure black. It 

is followed by the same grayscale shown in 26 steps. Finally, the same grayscale in 1-bit (2 steps):

:
Doing this to an image, we would get this:

All is grayscale in your PC. Each channel in RGB, is a grayscale (top), colorized (bottom):
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In the pure grayscale, first example on the previous page,there might be some banding, not 
unlike the 26 step example beneath it. This is due to printing anomalies.

If you wonder about the 16+ million colors you can get on your monitor, first, no one counted 
them. Each grayscale above shows 256 steps, and colors are made up of varying amounts of 
red, green, and blue. So if we what to know how many possible combinations there are, we can 
multiply the number of reds, greens, and blues together: 256 x 256 x 256 = 16,777,216 possible 
colors. Now, how many colors can be actually see? The best, most accurate estimate is millions 
and millions. Some studies suggest around 2.4 million colors, others, putting chromaticity and 
luminosity together suggest a number between 10-100 million. Most references suggest around 
10 million colors.

Here is a rhetorical question, in the set of grayscale images above, there are 256 steps in the 
first one, but only 26 in the second. Do we need all 256?

You might want a grayscale image in your book, either to keep costs down in a black and 
white book, or you have art work that was created as grayscale, like a black and white photograph 
or a charcoal drawing.

These three versions are remarkably close despite the rather large differences:* the black and 
white book prints at 106 lpi, where as the color book prints with 170 lpi screens. The CMYK ver-
sion prints with some color, which gives it a slight reddish/purplish cast, compared tot he black 
only printing of the other two.

If you want a grayscale image in a book (B&W Book and Color Book—K-only above), you 
can submit color and have CS convert it on the fly as it prints, or you can create your own gray-
scale images. CS does a decent job of converting color to grayscale—except: a lot depends on the 
images themselves. If you have a red logo with green or blue type then any conversion method 

* Like showing CMYK on a monitor or RGB in a book, showing the printed versions of an images requires 
some adjustments: scans are not 100% identical from image to image, and reprinting a halftone (ap-
plying a halftone to a halftone) will create a moiré pattern that not only creates a wave-like pattern, but 
it also changes the densities. To reduce the moiré problem, the images were blurred the same amount.
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that alters that relationship would be unacceptable. In the following examples, it will be clear that 
just pushing a button—whether it’s a “button” in CS’s printing process or in Photoshop—might 
be okay and might not be.

The two easiest ways to convert an image to grayscale is to desaturate the colors, or to rely 
on what your graphics program uses to change the color mode to grayscale: in some programs 
these are the same, in other not.

Looking at the color channels on the first page of this section, we could see choosing one of 
the channels to be the grayscale, or on more careful analysis, we might take part some of each 
and combine them. The most common formula is Red 30% Green 60% Blue 10%. This might be 
used by a particular program, or it is a place you could start in a Channel Mixer component of a 
graphics programs (setting the output to monochrome/grayscale if necessary).

Using the luminosity blending mode produces a grayscale images, which approximates the 
luminosity channel in Lab (a color mode available in some graphics programs), although not ex-
actly. And some people convert the image to Lab and use the L or luminosity channel, however, 
without any additional work, this tends to be flat.

In a graphics program, you can create layers, and each layer could be a different grayscale, 
and with the opacity slider, which can control the opacity of each layer from 0% to 100%, and 
with blending modes, it is possible to use several methods and combine them.

In fact, the next step would be to combine them selectively by masking in or out areas you 
do or do not want. You can also apply various adjustments (curves, levels, etc.) to entire layers or 
parts of layers with masks, or selections, which function like masks: the image on the previous 
page from the B&W book was prepared this way, so that I could compensate for the coarser screen, 
the paper, and the lack of additional color dots.

Fine art photography is usually printed as at least a duotone: two colors (these could be two 
blacks, or a black and a gray, where one often prints the darkest tones, and the other the highest 
tones.). By changing the gray or black to a warmer or cooler shade, reproductions can capture 
the subtleties of paper color or toning. With CS, if you need this, then scanning and printing in 
color is the only way to go. The third example on the previous page (Color Book—K-only) would 
be unusual because with all four process colors available using them generally leads to a richer, 
more accurate print, although at the risk of some misregistration (always a possibility with multi-
colored printing.

The great leveler is, of course, the halftone screen. It breaks the image up into only so many 
halftone dots per inch, although within each dot there can be up to 14 tiny dots of ink.

I cannot say how CS converts RGB or CMYK images to grayscale—I would assume it uses 
something like the grayscale mode, in the examples below; although I can say that it will add a 
little more contrast if the images are in CMYK.

Here are examples of using desaturation and changing the color mode to grayscale from an 
sRGB test image in several common graphics programs:
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Grayscales are also different if they are produced in RGB, CMYK, or CMYK K-only. 

These may look almost identical, and by the time they’ve been reduced to 25% their original 
size and printed, the point here is nearly lost. But in this example both the blacks and the contrast 
are different between them. Screening them to print will reduce the differences.

Certainly examples like the disappearing G and B on the previous pages, shows the potential 
for some problems to be far worse for some images and conversion methods.

K-only is, perhaps the most reliable conversion because it requires the least conversion by 
the output device: CS’s printer. There are two methods, setting the PDF for printing Device gray 
and converting the image to K-only prior to creating the PDF. I believe these are available in 
Photoshop and Acrobat

K-only: means black ink only; so whether printing in CMYK or not, only K values print. 
Grayscale images, that is monochromatic images in black only (right below), could be printed 
with CMYK values (left below).

CMYK grayscale K-only Grayscale

This is the same basic issue as Device gray below; however, this K-only was achieved inside 
Photoshop and was thus able to be adjusted there before it’s incorporation into a PDF—which is 
to say, the graphics manipulations to prepare the image were live and editable in Photoshop (no 
alterations were made to either image in this example).
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To create a K-only image in Photoshop:
•	 Convert the image to grayscale (ultimately* by Image > Mode > Grayscale)
•	 Convert the image to CMYK (Image > Mode > CMYK)
•	 Convert the image to monotone (Image > Mode > Duotone)
•	 Create a custom color setting and apply it to the image:

Edit > Color Settings > CMYK > Custom CMYK > Separation Options > Black Generation 
> Maximum

Again, this will be a K-only image, in CMYK, that can be adjusted in Photoshop before insert-
ing or converting into a PDF.

Device gray: refers to the color model and destination for black and white printing. In the 
PDF, before it enters the RIP, all color will have been mapped to black only. Printing is done with 
CMYK inks. Grayscale values could be made up of CMYK. By selecting device gray, all color 
is converted into values of black only (K-only), when the PDF is created, thus removing the need 
for the RIP to convert. These grayscale colors have no C, Y, or M color.

In the entirety of both the Acrobat and InDesign help manuals, over 1200 pages, only half 
a dozen lines are devoted to Device gray. From them only and without boundless curiosity, it is 
not easy to find Device gray. In InDesign, go to File > Print select Adobe PDF.

1) Color Panel options: . . . Convert All Colors To CMYK: Converts color spaces to De-
viceGray or DeviceCMYK according to the options specified in the Working Spaces menu. All 
Working Spaces must be specified. [page 85, Acrobat _X_pro_help.pdf]

2) Convert document colors . . . Promote Gray To CMYK Black: Converts device gray to 
CMYK.[page 434 Acrobat _X_pro_help.pdf]

3) Convert colors to a different color space: Depending on the color spaces you select, color 
conversion preserves, converts, or maps (aliases) color values from the source color space to 
the destination space as follows:

Objects with untagged RGB data (DeviceRGB) convert from the working space RGB 
profile to the CMYK gamut of the destination space. The same is done with untagged 
CMYK (DeviceCMYK) and grayscale (DeviceGray) values.[page 433, Acrobat _X_
pro_help.pdf]

* There are many things that can be done to the image in terms of grayscale prior to deleting the 
color information.
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This uses Acrobat Distiller: the Working Spaces dialogue is only accessible through Distiller. 
Depending on what other software is being used, you will probably go directly to this screen:

Or:

Click on Edit.
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You do not have to use PDF/X-1a. But you must convert to CMYK, and then in Working Space 
select Gray > Black and White. This will map all color to values of black.

The downside to producing grayscale, K-only, images this way is that the conversion is done 
when creating the PDF, not when actually adjusting the image for printing. Thus, you see the 
conversion after it has been made in a non-live state. Be that as it may, many people routinely 
use device gray when printing black and white books.

Every image is different and every preset does different things. One or more of presets or modes 
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might be acceptable. Without actually seeing and playing with a specific image, it is impossible 
to say, “Just convert to grayscale this way.”

Scanning & Shooting for Grayscale

If you are going to scan or shot something that is to be in grayscale:
•	 Scan or shoot in color: get as much image information as possible, convert it yourself, not in 

the scanner or in the camera.
•	 Scan or shoot at the highest optical resolution and/or size as is practicable
•	 For maximum control, adjust things like sharpness, contrast, color, etc., in a graphics program

Working with CS

This is probably way more information that most people will ever need, but having at least a 
general idea of what lurks about helps to make reasonable decisions.

CS prints grayscale images in black and white books at 106 lpi and 176 lpi in color:

As a practical matter, what I recommend is this—if possible convert your image using gray-
scale mode, and see if it is okay or if something lost: like the GB on Red, or flesh tones go too 
dark. Then from easiest/quickest to hardest/most time consuming:
•	 Submit RGB art and let CS convert to grayscale
•	 Convert the RGB art to CMYK, submit it, and let CS convert it to grayscale: it will have a 

little more snap than converting from RGB.
•	 Convert to grayscale using grayscale mode or a preset.
•	 Convert to grayscale using channel mixer
•	 Convert to grayscale and finesse the image:

•	 the blackest black should be black and the whitest white should be white*

•	 this can be done with curves or levels, with or without masking
•	 increase shadow and highlight details

•	 this generally requires masking
•	 Convert to K-only, then finesse the image.

As with working with color, print out your images, or at a minimum a few. Your desktop 
printer is likely to be more accurate than your monitor.

* If your images actually do not have a true highlight (white) or a true shadow (black) then do not artificially 
change the image.  However, print your image to see.  Most images benefit by setting the white and 
black points. 	
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Gutter: 1) The combined inner margins of two facing pages; 2) the space between two columns 
of text, more properly a column gutter. See Inner Margin.

“Gutter” is often used incorrectly, generally to indicate an 
additional amount of inner margin added to compensate for 
binding. In Word it is best set the gutter to 0”, then set the in-
ner or inside margin to what you want.

Halftone: a reprographic technique of using dots of varying sizes to create the illusion of continu-
ous tone (such is in photography or painting), in both black and white and color printing. 
Often referred to as a screen.

Left side only: < http://en.wikipedia.org/wiki/File:Halftoningcolor.svg>
04.22.11 Derivative work Pbroks13 

Hickey: A spot, ring, or similar imperfection in the printing caused by particle of some sort adher-
ing to a printing plate.

Hinting: A way to help type look smoother and clearer when displayed at low resolutions. In prac-
tice this looks like anti-aliasing (see jaggies), or it could be subpixel rendering on LCD or 
LED displays.

High key: High, low, and average key refer to images where the majority of tones are either 
high, low, or in the middle (average). Often this means no dark tones or shadows in high 
key images, and no highlights or high tone in low key images. However, it can also sim-
ply mean that the preponderance of tonality lies in the low, middle, or high area. These 
terms can also be used to describe lighting techniques.
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Low Key Average Key High Key

Highlight: 1) The lightest areas of an image; or the brightest part of an image as opposed to the 
shadow. 2) Specular light. If used to set a base point for setting range and color balance, 
it should/must be white.

Highlight value: The lightest value that can still retain some detail.

Holdout: Or ink holdout is the ability of a paper to prevent ink from being absorbed (absor-
bency). It is necessary for good halftone printing; however, too much holdout can result 
in setoff. It is the opposite of absorbency.

HSB and HSV: Cylindrical geometric representations of RGB color space.

<http://en.wikipedia.org/wiki/File:HSV_color_solid_cylinder_
alpha_lowgamma.png> SharkD CC and GNU copyright

Hue: That property that can be described as similar to or different from 
red, green, yellow, or blue. In painting hue refers to pure color, 
that is, without tint or shade.

Image area: The area of a press sheet that can be printed.

Image enhancement: Involves manipulating the pixels of an im-
age to achieve an effect. In prepress work that would mean 
adjusting it to print in CMYK the best. Generally, however,
this involves: crop, rotate, color, brightness and contrast, lighten/darken, painting/clon-
ing, levels, curves, and sharpening.
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Impose: To arrange and position pages for a given press sheet size to meet printing specification.

With most p-o-d printers, we don’t have to worry about im-
position or signatures. We can add single leaves to a book. 

Ink holdout: A characteristic of a paper surface that keeps ink for sinking into the paper. Good 
ink holdout, keeping the in on the surface of the paper gives better color saturation and 
detail. Too much holdout and there is a risk of setoff. See dot gain.

Inner margins: Page margins on the inside of the page, between the spine edge and the inside 
edge of the text block or image.

In Word, the Inner Margin setting in Page Setup is available 
when the margins are set to Mirror Margins.

Because of the tight binding, CS has minimum inner margins 
based on the page count:

Page Count Inner Margin Outside Margins
  24 to 150 0.375˝ at least 0.25˝
151 to 300 0.5˝ at least 0.25˝
301 to 500 0.625˝ at least 0.25˝
501 to 700 0.75˝ at least 0.25˝
701 to 828 0.875” at least 0.25˝

However, precisely because the binding is tight, wider inside 
margins between 0.875” to 1.25” are worth considering. 

ISBN: International Standard Book Number is an identifying number that ties the book’s title, 
author, and publisher together in a database. See barcode.

CS offers two types of ISBN: 1) Free: CS is the publisher of 
record; 2) Custom Universal ISBN (US members only):is an 
ISBN that may be used with any printer.

Jaggies: A form of aliasing caused by trying to create a curve or diagonal with square pixels. On the
left is an example of jaggies. On the right is a section of the same curve with antialiasing:
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JPG: An image format that uses an adjustable, lossy, compression. Image file size and quality can be 
varied from very compressed with poor image quality to little compression and maximum 
image quality. It does not support transparency.
The following example uses an 11.52″ x 7.68″ @300dpi image taken with a mediocre 
camera using medium quality setting was 3.63MB:

Original Size
in camera

Open Tiff
No compres-
sion

Tiff
Compressed

JPG
Max Quality Max Compression

3.63MB 22.8MB 23.3MB 10.3MB 6.0MB 0.3MB

When an image is compressed with JPG, the color values of an 8 x 8 px blocks are aver-
aged then the 8 x 8 px block is divided by an quantization matrix; and the original image 
data is discarded. When the image is opened, it is reconstructed. A jpg can be opened 
and closed a million times with no problems. When it is opened, saved, and closed, it 
has been compressed (data is lost), reconstructed (data is invented), and compressed 
again (data is lost).

             Original 6.0MB image                             Opened/saved/closed 100 times

The biggest losses in this image (mediocre snapshot) are in the highlight details. The 
bottom row shows the effects at 300% magnification (34.56″ x 23.04″ overall image 
size). Arguably, image degradation begins to be visible at between 5 and 10 open/save/
close cycles. In other tests, high quality images could survive 50 cycles. A JPG used in 
a PDF for printing is never opened/saved/closed, so there is no image degradation.

Here is a close up of the original on the left and the same image saved at maximum 
compression (minimum quality). Notice how the image is beginning to pixelate (broken 
into squares):
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Kerning: The space between letters. To kern is to adjust the space between certain letters to improve 
how they fit. For example: AV or AV, AT or AT,  Toyota or Toyota. Kerning should not be 
mistaken for tracking.

Kerning pairs: Two letters that have been moved close together. Although there are theoretically thou-
sands of possible pairs, many digital fonts have a much smaller number of pre-kerned pairs.

Knockout: When the foreground object meets the background without any overlap, such as have a colored 
background with text over it, normally this is printed with the background knocked out. See Trap.

K-only: In CMYK printing, eliminating the printing of CMY, and only printing in K (black) only.

LAB: An opponent color space. It was designed to model color opponent 
theory of human vision. L is the luminance channel, which looks like 
a B&W, desaturated version of an image. A and B channels are color 
information: A is green to red, and B is blue to yellow. Each involves 
imaginary colors: each color is 0 ,or “white” in the middle, and 
99,“black,” at the most saturated outside. The fully saturated darkest 
colors at the ends are imaginary: imagine a black red or a black yellow.

Laminate: 1) The process of adding a plastic film for protection or appearance to a printed 
piece. 2) The plastic film itself.

Landscape: An aspect ratio where the width is greater than the height. Images can be landscape 
or portrait.

Most CS books are portrait, but CS does do landscape any-
where from 6" to 8.5" high, by up to 8.5" wide. A variation 
on it with the binding along the top (like a scenic calendar) 
is possible: the PDF must be rotated 90°, so that the edge to 
be bound (the top) is the right, long, edge. You should inform 
Customer Support that the book will be top bound before you 
upload the PDF.

Layer: In word processing, graphics, and publishing programs, text and images can be placed 
on separate layers, like the separate acetate cells in analog cartoon making. Generally, 
each layer can be manipulated separately from the other layers. Here are six layers in a 
graphics program. Next to the image is the layers palette.
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Visibility—is controlled by turning on or off the little eyes. Then what we see is order 
from top to bottom in the layer stack. Transparency— is noted by the checkerboard. The 
Background layer has no transparency, but the other layers do. Active layer—any layer 
can be the active layer. Here the active layer is the star shape, and it has been made 50% 
opaque with the Opacity slider, which adjust the layer that is active, although all the lay-
ers could be adjusted, one at a time. Layers—are shown both with layers in the layers 
palette and also graphically with the little thumbnails. Layer order—each layer can be 
dragged up and down in the layer stack: thus, the red circle, if dragged to the top, could 
cover parts of all the other layers.

Saved in its native file format, all the layers remain intact. Saved 
as a jpg, flattened, or printed, invisible layers, the top layer, a 
black X in this example, will either be removed or won’t print. 
One or more layers can be invisible.

Leading: The spacing between lines of text, measured from base line to base line, thus 12 point 
type with 2 points of line spacing would be called 14 points; and this would be specified 
as 12 on 14. Pronounced “ledding,” it comes from the use of thin lead shims inserted 
between lines of type for spacing. Also called interlinear or interline spacing, or simply 
line spacing.

Word set to Single (Paragraph > Indents and Spacing > Spacing > 
Line Spacing > Single) adds 15% of the fonts size for leading: 
therefore single spacing is 12/13.8, 14/16.1, 20/23, etc.

Leaf: A single sheet of paper bound into a book. Each leaf is two pages.
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Levels: A graphics program tool that adjusts the black, white and gray points of an image.

Ligature: Two or more letters combined into one glyph. From Minion Pro—
Th fb ff ffb ffh ffi ffj ffk ffl fft fh fi fj fk fl ft ct sp st

Some ligatures are applied automatically (e.g. Th or fl), while others, called discretion-
ary (e.g. ct, or st) are not. Not all fonts have ligatures.

Light fastness: The quality of colored ink or paint, etc. to resist changing in due to the effects 
of UV in light. 

Lightness: A property of a color, describing color along a 
light-dark axis, also called value (Munsel or HSL)
or tone. Here is a grayscale step wedge going from light to dark. 

Line art: An image made up of distinct lines (curved or straight), generally on a plain 
background, with no gradations in shade or hue. It can be vector or raster. 
Also called line drawing.  

Lpi: Lines per inch. This refers to the number of dots or line per inch in a halftone screen. 

Live: A live area is that portion of a layout or press sheet that prints. Also known as the safe area 
or image area. 

CS: “out-of-live” and “live elements” refer to text and/or images 
of text (a logo on a box, a stop sign, Pharsi graffiti, etc.) even if 
they are in the background of a picture). CS has an out-of-live 
margin for covers and interior pages.  

Lossless: An image compression method, to make a smaller size file, where there is no image 
degradation, it is called lossless compression, PNG, for example.

Lossy (lossee): An image compression method, to make a smaller size file, where there is image  
degradation, it is called lossy compression. An image can be opened and closed a thou-
sand times with no additional degradation; however, each time it is opened and saved, 
there is some degradation. As a practical matter, images saved as JPGs at maximum 
quality (10-12 using Photoshop’s system, or roughly 85%–100% quality) should not 
show artifacts of compression. See JPG for examples.

Low key: see High Key

Lpi: Lines per inch. Lpi is used to designate the number of dots per inch in a halftone screen. 

CS uses 106 lpi for black and white, and 170 lpi for color. 
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Luminance: 1) A measure of light energy radiating from a subject or color. See Brightness. 2)  
The luminance channel, L, in Lab. Below: full color, L (luminance), a and b channels.

Make-ready: The steps necessary to get a press ready to print. 

Map: To take specific pixel values and systematically adjust them, as when out-of-gamut colors 
are mapped to different values.

Mask: A mask is like a stencil—it protects specific image areas from being changed or allows 
specific areas to be altered. See Selection, Clipping path

Mechanical: The complete camera or print-ready art (text and images in position). It can be 
used to refer to both paper and digital work. 

Merge: When working with multi-layered images, merging combines all the visible information 
into one layer, but it leaves untouched other layers that are not visible. See layers.

Metamerism: The apparent matching (to the human eye) of colors made up of different spectral 
qualities—colors that match are called metamers. Illuminant metameric failure (col-
loquially, often just called “metamerisim”) occurs when two matching colors viewed 
under one light source do not match under a different light source.

Mirror Margins: A setting that flips the margins set on one page to the other, so that both pages 
have the same outer and inner margin settings. 

Midtone: The range of tones between the shadows and the highlights.

Misregistration: When one or more colors is printed slightly off from the other colors. See Trap.
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Moiré Pattern: An interference pattern, most often it is caused when a pattern is used over a pat-
tern: two misaligned halftone screens; or patterns that are scanned at certain dpi settings. 

Monochrome: A one color image. Most commonly this is used to describe a grayscales, but it 
could be the range of 0% to 100% of any color, below right is a blue monochrome.

Mottle: A printing defect where solid areas of a color appear spotty and uneven.

Neutral: 1) White, grays, and black; 2) An image or part of an image that does not appear to 
have prevailing color.

Newton’s Rings: Irregularly shaped rings of color occurring when images are scanned. This 
happens with film or glossy images that are not is firm contact with the transparent 
platen or drum of a scanner.

Noise: The presence of pixels that have nothing to do with either the detail or color of an im-
age—similar to film grain. Generally, noise is undesirable and is due to low image qual-
ity, see Jpg. Sometimes, however, it might be desirable, and could be added to break up 
a flat, smooth solid area or to prevent banding in gradients or banding streaks in light, 
solid, colors.

Non-lining figures: Resemble text by having various heights. Compare non-lining/old style 
0 1 2 3 4 5 6 7 8 9 to lining figures: 0 1 2 3 4 5 6 7 8 9. These are used to permit the use of 
figures in text without drawing too much attention to themselves. They are not used in 
tables. Also called old style figures.

Offset printing: A form of printing where the inked image is transferred (offset) from a plate 
to a rubber blanket to the printing surface. Commonly it is used with the lithographic 
process which is based on the repulsion of oil and water, where ink is applied to a flat 



4141Moiré Pattern–Paper

image carrier (plate), while a water based film is applied to the non-printing areas, 
keeping them ink-free. Non-digital offset printing uses film or digital image files, from 
which metal plates that will carry the inked image are made (some presses use short-run, 
throw-away, plastic plates). See Digital printing.

One-up: Printing only one item (generally a page) on a press sheet.

Opacity: The ability of a paper preventing show-through.

Open type: see type

Opponent Process: A color theory based on the visual system of the human eye. There are 
thee types of cone: long, medium, and short (rods, a photoreceptor cell, is primarily 
responsible for night or low light vision). The differences between them result in three 
component channels red/green, blue/yellow, black/white (luminance). Responses to one 
color of an opponent channel (red/green, or blue/yellow) are antagonistic to those to the 
other color: opposite opponent colors are never perceived together – there is no blueish 
yellow or greenish red. See LAB.

Out of Gamut: color that will not print.  Many RGB colors are out of gamut in CMYK. See 
pg. 13.

Outside margins: The page margin opposite of the binding, sometimes called the thumb edge 
or front.

Out of register: see misregistration

Output device: Printer, monitor, imagesetter, etc.

Overprint: In appearance, this is similar to knockout, where a foreground object is printed 
over a background, but the difference is that unlike the knockout, here the background 
remains underneath the foreground object, also surprint.

Page: One side of a leaf, or bound sheet of paper; each leaf has two pages.

Pagination: Traditionally the division or arrangement of content in discrete pages. Commonly, 
it now means the process or system by which pages are numbered.

Paper: Paper is a thin material used for writing, drawing, printing, and packaging. Most com-
monly it is made from wet organic fibers, usually cellulose pulp from wood, rags, and 
various grasses. Lignin and cellulose are the major components, and although Lignin is 
a vital part of plant life, it is one of the chief reasons for paper yellowing and becoming 
brittle. Ideally it is removed during what is called the pulping stage of paper making.

Fillers—minerals, starches, brighteners, bleaches, etc.—are added to the pulp. The pulp 
is fed into a machine that form the paper, which is dried through evaporation and/or 
heat and/or pressure. After the paper is formed, it is finished. This can involved coating, 
sizing, calendering, etc.



Paper
A4: The most common paper size in the world: 210 mm x 297 mm (8.27″ x 11.69″), the two 

major exceptions are the US and Canada that still use
letter size (8.5 x 11). See A series.

A series: An international paper size standard. The basic sheet size, A0, 
is 841 mm x 1,189 mm (33.11″ x 46.81″). Each successive size is 
made by halving the long dimension of the preceding paper size:

Acid free: Papers having a that have no acid in the pulp

Archival Paper: Generally any relatively colorfast paper that is acid and lignin free,

Basic size: The standard size of a specific paper grade:
Paper Grade Size in inches

Bond, ledger, manifold, mimeo, railroad manila, writing 17 x 22
Blotting 19 x 24
Box cover, cover 20 x 26
Manuscript cover 18 x 31
Blanks, tough check 22 x 28
Mill bristol, postcard, tag, wedding bristol 22.5 x 28.5
Index bristol 25.5 x 28.5
Mill bristol 22.5 x 35
Box cover, glassine, hanging, newsprint, poster, tag, tissues, wax-
ing tissues, wrapping, wrapping tissues

24 x 36

Bible, book, box cover, gummed, offset 25 x 38

Basis Weight: The weight of a ream (500 sheets) of paper at its basic size.

Bond: Strong, durable paper used for letterheads, copiers, printers, stationary, etc., consisting of 
wood, cotton, or both.

Book: A general classification for papers that are suitable for books and other graphic arts. Book 
paper can be coated or uncoated; it is equivalent to text paper in weight.

Brightness: The measurement of light reflected back from paper. It can be used to gauge how 
much lignin is in a paper. Paper manufacturers uses fillers to increase the brightness. It 
is based on the 100% reflectance of a magnesium oxide tile. This is not the same thing 
as whiteness.

Buffering: An alkaline substance add to the paper pulp. It acts to protect against acid formation 
in the paper or from the environment.



Bulk: The thickness of paper. High bulk papers have fewer sheets per inch than low bulk sheets. 
Bulk is not necessarily related to weight.

Calendering: In paper making, a process of running paper through steel rollers (calenders), giv-
ing it a more uniform thickness and varying degrees of smoothness.

Caliper: The thickness of the paper in thousandths of an inch, 0.001″, also mil.

Card stock: A paper stock that is generally thicker and more durable than bond, book, or offset 
paper. Also called cover stock or pasteboard.

Cast Coated: A high gloss paper made by casting the coated paper against highly polished, 
heated

Cellulose: The main part of the cell walls of all plants. Cotton is 91% and is the purest form of 
natural cellulose.

Coated: Paper made with a surface coating designed to enhance printing—generally by increasing 
the smoothness and ink holdout. Coated papers can run from dull to matte to high gloss.

Cold Pressed: A slightly textured paper surface produced by finishing the paper between cold 
calenders. A finer harder surface is achieved using hot calenders: hot press.

Cover stock: Also called card stock. It can be coated or uncoated. It is often referred to by the 
thickness in points.

Deckle Edge: The feathered edge of a piece of paper, used for aesthetic reasons for stationary 
and books.

Fiber: The small strands of wood, cotton or other cellulose materials that are used to make the 
paper. Premium paper is lignin free. See pulp.

Filler: Natural or man made minerals, such as clay, added to pulp to improve the opacity, 
smoothness, brightness, and printing characteristics of paper.

Grade: The classification of various types of paper due to their individual characteristics— 
brightness, opacity, cotton content, etc., such as book, bible, etc.

Grain: Against the grain: at right angles to the paper grain. Folds are best made with the grain, 
not against it. Direction of the grain: the direction of the fibers in paper. Grain long: the 
grain is parallel to the longest edge of the paper. Grain short: the grain is parallel to the 
shortest edge of the paper.

Grammage: The basis weight of paper stated in metric terms of grams per square meter and 
expressed as g/m2.

Handmade: paper made by hand as opposed to being machine made. These are general papers 
used for crafts or painting, not for commercial printing.



Laid Paper: A paper with finely spaced lines pressed into it.

Lignin: the organic material in wood that holds cellulose fibers together. It is directly related to 
the lack of durability in paper, causing yellowing and embrittlement due to production 
of acids.

Lint: Fibers from the paper that can buildup on various parts of the press and cause printing 
problems.

Paper weight conversion: These values are general: each paper company may have its own 
specifications.

Equivalent Weight in Pounds Equivalent Thickness

Bond
Ledger

Offset
Text

Cover Tag Index Points Thickness
inches

Thickness
mm

G/M2

16 40 22 37 33 3.2 0.0032 0.081 60.20
18 45 24 41 37 3.6 0.0036 0.092 67.72
20 50 28 46 42 3.8 0.0038 0.097 75.20
24 60 33 56 50 4.8 0.0048 0.120 90.30
28 70 39 62 58 5.8 0.0058 0.147 105.35
29 73 40 64 60 6.0 0.0060 0.152 109.11
31 81 45 73 66 6.1 0.0061 0.155 116.63
35 90 48 80 74 6.2 0.0062 0.157 131.68
36 90 50 82 75 6.8 0.0068 0.173 135.45
39 100 54 90 81 7.2 0.0072 0.183 146.73
40 100 56 93 83 7.3 0.0073 0.185 150.50
43 110 60 100 90 7.4 0.0074 0.188 161.78
44 110 61 102 92 7.6 0.0076 0.193 165.55
47 120 65 108 97 8.0 0.0078 0.198 176.83
53 135 74 122 110 9.0 0.0085 0.216 199.41
54 137 75 125 113 9.0 0.0090 0.229 203.17
58 146 80 134 120 9.5 0.0092 0.234 218.22
65 165 90 150 135 10.0 0.0095 0.241 244.56
67 170 93 156 140 10.5 0.0100 0.250 252.08
72 183 100 166 150 11.0 0.0110 0.289 270.90
76 192 105 175 158 13.0 0.0130 0.330 285.95
82 208 114 189 170 14.0 0.0140 0.356 308.52
87 220 120 200 180 15.0 0.0150 0.380 312.00
105 267 146 244 220 18.0 0.175 0.445 385.06



To use the chart, for example, CS uses 60 offset, to get 
an equivalent of that, the chart indicates that 24 lb bond 
paper would be similar.

Picking: A deformation of the paper surface caused during ink transfer by the force of sticky 
ink that either separates layers of the paper, or removing chunks of the paper coating. 
Pick resistance is thus a description an important aspect of paper in the printing process.

Ply: A single layer or sheet of paper.

Porosity: The more porous a paper is the less the ink holdout, the poorer images will print, the 
greater the dot gain.

Printability: The interrelationships of paper properties—surface (finish, gloss, ink absorbency, 
etc.) and structural (bulk, dimensional stability, weight, pick resistance, etc.)—that re-
sult in high-quality printed images.

Pulp: The fibrous material used to make paper. It can be made from wood, cotton, or linen, for 
example. The higher the cellulose content of a paper, the better the quality, so cotton, 
almost 100% cellulose, produces the best pulp, as do linens, and other textile materials. 
Wood, with a lower cellulose content, produces pulp that is not as good as cotton, or, 
but with chemical treatment the quality of paper made from wood pulp can be greatly 
improved.

Pulping: the process of preparing the pulp for paper making, by removing the lignin and other 
impurities.

Rag: Rag paper—paper made from cotton. Rag pulp—paper pulp made from new or old cotton 
or linen rags.

Runability: The qualities of a paper that determines how well it performs. Not just how well it 
prints, see printability, but that it does not cause problems on press. Loose fibers, dust, 
coatings and fillers that remain intact, or not, curling, etc. can effect how well a paper 
handles on a particular press.

Size: Any substance mixed into the paper pulp or sometimes by coating that improves printing 
qualities. Most commonly these are starches or latex.

Watermark: 1) A design, symbol, or pattern applied to the surface of the paper while it is being 
formed. This is usually done by having the pattern on the wire support for the paper or 
by passing the paper through a metal roll with the corresponding mark on the surface of 
the roll (dandy roll), usually with a wire pattern on the wire. 2) A feint printed mark on 
the surface on image or behind the text, used to identify the owner, the copyright, that 
it’s a copy, or proof, etc.



Web: 1) The name for the paper as it is formed on a paper making machine. 2) Paper sent as a 
roll to be printed.

Whiteness: An optical property of paper that describes the quality of reflected light, compared 
to the ideal white standard (a powder of barium sulfate) that reflects 100% of all light 
falling on it. Generally, there are three shades of white paper: balanced white, warm 
white, and blue white. Most paper are manufactured with a blue white because to the 
human eye, this appears whiter.

Working with CS

CS offers these papers:
Color Books: 60# smooth bright white off-set
Black and White:
White paper: 60# off-set
Off-white paper: 60# cream off-set
Cover stock: 10pt C1S

That is the full description, verbatim, which is not very helpful. Offset, which is often synonymous 
with book paper, simply means that it is suitable for offset printing. It can be coated or uncoated.
All of the papers are approximately the equivalent thickness of the 24 lb bond paper we buy for our 
desktop printers. People are often shocked by the white paper for books, but I think that is more 
because books from most traditional publishing companies are on a cream stock. The cream is a 
little more yellow than most, but a casual visual comparison of ten novel chosen as representing 
a range of off-white papers, CS fell about equal to the sixth or seventh. However, both the white 
(black and white book) and cream stocks vary enough that to give a color equivalent could be 
misleading.

The color book stock has been treated 
to make color printing—halftones—clearer, 
sharper, brighter. Arguably this has been done 
in part with a coating. While, then this could 
be a coated stock, it is not enameled, clay, cast, 
or blade coated. Unlike the white and cream 
stocks, which, as mentioned above, vary in 
color, samples of the color book paper going 
back to 2002 (with BookSurge) have not ap-
peared to vary at all.
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PDF: Portable Document Format. Originally a proprietary format of Adobe’s, it became an open 
standard in 2008. This is a file format that preserves as much information about a docu-
ment as possible (depending on the chosen preset). There are two main ISO standards:
•	 PDF/X, also known as PDF exchange, meets various graphics standards, including 

embedding fonts, removing transparency, converting all images to CMYK, defining 
the output device standard, etc.

•	 PDF/A, also known as PDF archive, retains RGB and CMYK images, but embeds 
fonts, and removes transparency.

Other presets (to my knowledge only found in Acrobat Pro):
•	 High Quality, “Creates PDFs for quality printing on desktop printers and proofing 

devices. This preset uses PDF 1.4 (Windows) or PDF 1.6 (Mac OS), downsamples
color and grayscale images to 300 ppi and monochrome images to 1200 ppi, em-
beds subsets of all fonts, leaves color unchanged, and does not flatten transparency 
(for file types capable of transparency),” Adobe Acrobat Help.

•	 Press Quality, “Creates PDF files for high-quality print production . . . but does not 
create files that are PDF/X-compliant. . . . the quality of the content is the highest 
consideration. The objective is to maintain all the information in a PDF file that a 
commercial printer or print service provider needs in order to print the document 
correctly. This set of options uses PDF 1.4, converts colors to CMYK, downsam-
ples color and grayscale images to 300 ppi and monochrome images to 1200 ppi, 
embeds subsets of all fonts, and preserves transparency,” Adobe Acrobat Help.

Although Adobe Acrobat is the standard, many free conversion programs like primoPDF, 
do PDF, cutePDF, do an adequate job.

PE: printer’s errors are mistakes created by the printer or typsetter.

Perfect bound: is the binding most commonly associated with paperbacks. The pages (sig-
natures) are gathered and the spine edge is sheared off. Glue is applied to it or to the 
cover, which is wrapped or folded over the text block. The three remaining sides are 
then trimmed.

CS uses a tight binding that is visually about 0.25” less than 
what appear in the PDF. There is also a binding crease that 
runs parallel to the spine about 0.25” in.



PDFs for Commercial Digital Printing
PDF stands for Portable Document Format. The goal of using a PDF is to produce a facsimile 

of your document that is device independent: that is, it can be opened without having Word for 
a Word file, or a specific printer if you print out the document. PDF is the file extension (myfile.
pdf). Originally this was an Adobe creation, and the program was Acrobat—Acrobat Reader is 
the free Adobe PDF reader, Acrobat Pro or Standard are the Acrobat stand-alone programs used to 
create PDFs. However, in 2008 Adobe issued a public patent licences—royalty free—for Acrobat 
patents, to encourage reliance on PDF technology and standards.

There are now many companies that provide free and low cost PDF conversion programs. 
Most of these programs do not adhere strictly to Acrobat’s standards, several of which are now ISO 
standards, for example PDF/X (used for graphics exchange, developed for commercial printing), 
and PDF/ A (developed for archival purposes).

Most commercial digital printers print from PDFs.; and most of them specify PDF/X-1a.
PDF conversion programs (including Acrobat, which can be accessed as a printer) install as 

virtual printers. To create a PDF, File > Print > Select the printer then select the PDF conversion 
program from your available printers. Do not click <Print>. Depending on your system or ap-
plications, you may have to click <Set up> or <Options>, you are looking for a button that says 
<Preferences> or <Options>. Sometimes the settings are immediately available, sometimes you 
have to find <Advanced>* (not all conversion programs have all these options):
•	 Paper/trim/output size—most of these programs default to 8.5 x 11. If your document is dif-

ferent from that you must check that the PDF size is set correctly.
○○ In Reader: mouse over lower left corner or File > Properties > Description to see the 

actual size of the PDF pages. 
○○ Downsizing—also called downsampling. Most programs permit downsizing (e.g. 

300 ppi > 200 ppi†). Do not downsize unless you know you need it. Most programs 
default to either 300 ppi or downsizing is deselected/grayed out.

○○ Without Acrobat or some other premium conversion program, you cannot tell the 
image resolution of images inside a PDF.

•	 Compression—Most programs permit adjusting compression.‡ For printing, 85% to 100% 
image quality, Adobe uses a 1-12 scale, with Maximum quality being 10-12.

* See notes at end for more detailed information.	
† PPI/DPI: many graphics programs use ppi (pixels per inch); however commonly people say dpi 

(dots per inch) for the units of measure for image resolution, although it is incorrect. If you printed one 
pixel (the smallest single element of a rasterized image) at 300 ppi on the Canon Pixma desktop inkjet 
printer, it would require 1,024 tiny drops of ink, because the Pixma prints at printing resolutionof 9,600 
dpi. I continue to make the distinction not because it technically correct, but because understanding 
the difference between actual dots of ink and pixels is important.

‡ Compression: quality and file size (compression) are inversely related. If you want maximum quality, 
the amount of compression will be relatively small. If you want the smallest possible file size, the quality 
will be very poor.	
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○○ There is no way to know if an image has been overly compressed by any number or 
test. Viewing it or printing it may show compression problems.

•	 Font embedding—you want to embed (fully or subset) the fonts you use in your document. The 
alternative is that system fonts are substituted. Some programs call embedded fonts softfonts, 
and will let you select “Download as softfonts.” Do not use, “Substitute with device fonts.”

○○ In Reader, go to File > Properties > Fonts to see if the fonts are embedded or not. If 
the fonts are listed but do not say “Embedded” (complete or subset), they have not 
been embedded.

○○ If you create a PDF with a font that is not embedded, the PDF will look okay on 
your computer because Reader will use the font on your computer. But on a different 
computer that does not have those fonts, substitute fonts will be used and the format-
ting will change.

•	 Transparency—ideally you want to remove transparency before commercial printing because 
you will see any color shifts, and there is less likelihood of problems. This may not be an 
available option (e.g. PDF/A, PDF/X-1a, and PDF/X-3, remove transparency; PDF 1.3 com-
patibility does too).

○○ Transparency (drop shadows, vignettes, blending modes, objects on a transparent 
background, translucent objects, etc.) must be removed (flattened) by the printer prior 
to printing. This often results in shifts in color. JPGs do not support transparency, but 
PNGs, TIFFs, GIFs, etc., do. Multilayered files have transparency.

○○ PNG files with transparency (clear backgrounds, drop shadows, vignetting, etc.) do 
not always work—especially in Word. Tiff files with transparency or JPGs (with the 
transparency flattened/removed) generally are not a problem.

○○ Without a program like Acrobat Pro, you cannot determine if the PDF has transparency.
•	 Output resolution—this sets the resolution of the ouput (printer, etc.) device.* Most com-

mercial digital presses use 2400 dpi, often referred to as addressable resolution; laserjets are 
typically 300 to 600 dpi, a new inkjet printer could be 4800 x 1200. The higher the number 
the sharper and clearer the image. Check with your printer. Note: this does not convert your 
images to that resolution.
For Acrobat Distiller or non-Adobe products, select the PDF virtual printer, and click on 

Preferences or Printer Properties. This will bring up a properties screen:†

* It is here we see the need for just using dpi for resolution. Digital image resolution is given in pixels 
per inch (ppi). A printer’s addressable resolution, is given in dots per inch (dpi); and those dots can 
be made up of droplets of ink also given in dots per inch (dpi). And if the work is to be commercially 
printed, continuous tone images (JPGs for example) will be screened, that is, converted into halftone 
dots, measured as lines per inch, lpi (although they are dots).

† Not all of the screens will look exactly like this or have all the same settings, but these representative 
enough to make things clear for most PDF conversion programs.



Prepress Glossary50

If you use a conversion program that permits selecting for black and white or color printing, 
make the appropriate selection. Then click on Advanced to make the rest of the necessary changes.

Most conversion programs default to 
8.5 x 11 paper. To select the correct paper/
output/trim size, open the drop down sizes 
and if the size of your work is not listed, 
select PostScript Custom Page Size—left. 
This will immediately open the PostScript 
Custom Page Size Definition dialogue.

Right: enter the correct page or trim size.
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Left: click on True Type Font for the font 
embedding setting. Select Download as 
Softfont to embed the fonts.

Right: to set the output resolution click on 
Print Quality and in the drop down menu 
select the appropriate resolution.

PDF Presets
Adobe Acrobat offers a number of presets that are unavailable in most other PDF conversion 

programs. If you don’t have Acrobat, it is still worth understanding what these presets are because: 
they are often referenced when specifying what type of PDF is required for certain uses; they 
provide a sense of what features to look for in non-Acrobat programs. In Acrobat most of these 
features, and many more, are editable, the table indicates the default settings:

Preset Embeds
fonts

Transpar-
ency

Color mode Downsamples
Color Mono

Compression
Quality

Output
Resolution

PDF

PDF/X-1a Yes Flattens Converts to CMYK 300/ 450 1200/ 1800 Maximum 2400 dpi PDF 1.3
PDF/X-3 Yes Flattens Does not change &

embeds profiles
300/ 450 1200/ 1800 Maximum 2400 dpi PDF 1.3

PDF/A-1a Yes Flattens Converts to either
CMYK or RGB

300/ 450 1200/ 1800 Maximum 2400 dpi PDF 1.3

Press Quality Yes Preserves Converts to CMYK 300/ 450 1200/ 1800 Maximum 2400 dpi PDF 1.4
High Quality Yes Preserves Does not change 300/ 450 1200/ 1800 Maximum 2400 dpi PDF 1.4
Standard Yes5 Preserves Converts to sRGB 150/ 225 1200/1800 Medium  600 dpi PDF 1.5
Smallest No Preserves Converts to sRGB 100/ 150 300/ 450 Low  600 dpi PDF 1.5

* By default Standard will not embed “Windows font” (Acrobat Help, page 80) subsets. These are also called Base 14 
fonts, the fonts that are part of Acrobat: Times (v3) or Times New Roman PS MT (v4.x), Helvetica (v3) or Arial MT 
(v4.x), and Courier, Symbol, and Zapf Dingbats.
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Most commercial printers prefer PDF/X-1a‑; however, many will accept other presets. Check 
with your printer. A quick overview of some popular print-on-demand, p-o-d, printers:

Preferred
Preset

Embed
fonts

Transparency Color Mode/Management Image
dpi

PDF
compatibility

48hrbooks High Quality
or DoPdf

Yes Accepts N/A PDF 1.4 or ?

Blurb PDF/X-3 Yes Flatten sRGB; other RGBs convert to 
CMYK

300 PDF 1.3

CreateSpace N/A* Yes Accepts with
warning

RGB and/or CMYK ≥300 PDF 1.4

Espresso PDF/X-1a Yes Flatten RGB or CMYK 300 PDF 1.3
Fidlar High Quality Yes Accepts CMYK 300 PDF 1.4
Lightning Source PDF/X-1a or

High quality
Yes Flatten CMYK; TAC 240% 300 PDF 1.3

Lulu PDF/A Yes Flatten RGB or CMYK; TAC max. 
270%, min. 20%

300 PDF 1.3

* Accepts other formats (doc, docx, rtf, pdf)

Here are comments on several PDF conversion programs (these are Windows programs). The 
test was run with a small file, consisting of some text in black and three images. The Word docx 
file (not used, was 8.554MB, and the Word doc file (used), was 4.326MB:

Files Size Color
B&W
Setting

Special
Setting

Transparancy Image Text; PDF 
Compt-
ability

Acrobat HQ 1.911MB No — Yes RGB K-only PDF 1.4
Acrobat PDF/X 2.455MB No — No CMYK K only PDF 1.3
doPDF (free) 5.747MB No High Quality No RGB PhotoShop K* PDF 1.5
NitroPDF 2.51MB No Print Ready No RGB RGB Black PDF 1.4

OpenOffice (free) 2.137MB No PDF/A No RGB RGB Black PDF 1.4

PDF995 (free) 1.289MB Yes — No RGB PhotoShop K* PDF 1.3

PrimoPDF (free) 1.291 Yes Prepress No RGB PhotoShop K* PDF 1.4

Word2010 0.466MB No PDF/A No RGB RGB Black PDF 1.4
* Photoshop Black text is screened. However, many people have used these programs, and where I have been able to 

check, OpenOffice and LibreOffice, their text was not screened.

•	 Where there is Black C0 M0 Y0 K100) text other black objects over color (overprint), PDFs 
made in InDesign default to convert K-only to overset black—the default can be deactivated.

•	 K-only is black ink only (C0 M0 Y0 K100).
•	 Word’s Save as PDF feature downsized the images to 200 ppi (dpi) from 300: do not use.
•	 Based on the file size (not any actual print test), I would lean towards Acrobat, doPDF, Ni-

troPDF, and OpenOffice.
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If you do not have Acrobat or other Adobe products that enable saving as PDFs, text is gener-
ally saved as Photoshop Black (rich black) or R255 G255 B255 (black). Text printed from these:

PhotoShop Black R255 G255 B255 (K-only)
Color Books Halftone screen, darker text, 4 color, possible 

misregistration problems
100% black, no halftone screen

B & W Books Screened, lighter text (95±%) 100% black, no halftone screen

This may or may not be a problem; I tend to think that from CS forum complaints, it is rare, 
despite my tests: and when it occurs it is seldom a problem. But funny things can happen, and 
having some sense of where they might come from would be helpful.

Conclusion

Acrobat is the best program (most consistently reliable with the most options) to use for creat-
ing PDFs—but many of the free conversion programs work well for many people.

While all the conversion programs listed above worked, in tests run a few years ago, one of 
the free programs did not work for me, but it worked well for other CS members. My conclusion 
then was that some of the conversion programs might not work for everyone—probably due to 
software conflicts—but another free program can be downloaded: which makes more sense than 
struggling for days to create a PDF.

If images are involved, given Word’s downsizing, do not use Word 2007-2010 Save as PDF 
feature. Only NitroPDF ($119) and OpenOffice/LibreOffice, offer the security of PDF/A and full 
black text.

Resizing PDFs

Sometimes the trim/paper size of a PDF must be changed, but the original (source) file no 
longer exists.
•	 Open the file in Reader
•	 File > Print > Select printer
•	 Select your PDF conversion printer
•	 Set the output size to whatever size is desired.

○○ if the size is smaller, image resolution will increase
○○ if the size is bigger, image resolution will decrease
○○ Image proportions may change to fit the ne new size, i.e. there might be some 

distortion compared to the original.
•	 Embed fonts—select Download as softfonts.
•	 Make sure the graphic or print quality is set to the printer’s recommend resolution, the 

default for PDF/X is 2400.
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Pica: A typographic unit of measure, equal to 12 points, or 1/6 of an inch, 0.166 inch.

Pixel: From picture element, is a single display point in a raster (bitmap) image. It is the smallest 
element in an image that can be represented or controlled. The resolution of an image 
is ppi, pixels per inch; although commonly most people refer to it as dpi, dots per inch.

Pixelated: An image quality where individual pixels are visible. See Resolution.

P-o-d: see print-on-demand.

Point: A unit of measure for type, 1/72" of an inch, or approximately 0.0139". Type for a book 
is normally described by is its size and leading: 12/14 (read “12 on 14”), which means 
twelve point type with 2 additional points of space between lines. Type set solid, that is 
no additional spacing is, for example, 12/12, or 10/10.

Portrait: An aspect ratio where the height it greater than the width.

PPI: pixels per inch—the resolution of an image. However dpi is used commonly over the more 
more correctly ppi.

Preflight: is the process of confirming that everything required for printing is in the print-ready 
file (embedded fonts, no transparency . . . .) and that everything is valid. Various stan-
dards can be used to check against (PDF/X, PDF/A, etc.) as well as individual aspects 
that might cause trouble (image resolution, for example).

Prepress: is a general term used in printing to indicate the processes and procedures that occur 
between layout and printing: these can include typesetting, editing, proofreading, proof-
ing and outside CS, would also include screening, imposition, separations plate, etc.

Press run: the total number of copies to be run of a specific job.

Press sheet: a single printed sheet. It usually refers to a sheet pulled at random during or after 
a press run.

Primary color: although almost any set of colors could be designated primary colors in some 
color system, in practice we are concerned with red, green, and blue in RGB, and cyan, 
magenta, yellow, in CMYK. See Secondary color.

Print-on-demand: (also p-o-d) printing work when needed, as opposed to printing several thou-
sand or more copies at one time then fulfilling orders from an inventory. This work must 
be done on a digital press, where printing one copy is as easy as printing a hundred. 
Although work printed on an Indigo press can be proofed and adjusted page by page, 
this is not practical for print-on-demand.

Print ready: Before digital images and prepress, work that was ready to go to the printer was 
said to be camera ready, that is, ready to be shot by a process camera to generate film 
from which printing plates would be made. With digital images and prepress, digital 
work that is ready to be printed is print-ready. CS requires PDF files.
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Process color: Colors that are used for four-color offset printing to reproduce the full range of 
colors. They are cyan, magenta, yellow, and black, referred to as CMYK:

 

                Pantone Process Colors                          CreateSpace Process Colors

Profile: see Color Profile

Quartertone: The tonal range of an image that falls between the highlights and the midtones. 
Also one-quarter tone.

Raster: From the name of the parallel grid of scanning lines in a TV or monitor. Raster graphics 
are bitmapped images, where each pixel is mapped (each bit or byte is mapped), pixel 
location by pixel location. Jpg, tiff, png, psd, bmp, and gif are examples of raster image 
file types. Because every pixel is mapped, the larger the image the more pixels and the 
bigger the file. See Sampling

Raster art: Bitmapped images (jpg, tiff, etc.)

Rasterization: To convert vector art (type for example) into bitmapped art.

Reader’s spread: The pages of a document that are organized as they will be read and numbered.

When Word displays pages as spreads, it shows them 1-2, 3-4, 
5-6 . . . odd on the left, even on the right. However, in a book the 
reader’s spreads are 1 (first, odd page on the right), 2-3, 4-5, 6-7. . . 
that is, the spreads are even (left side), odd (right side). OpenOf-
fice/LibreOffice has a correct book view. Also, in Acrobat Read-
er, open a document, then select View > Page Display > Two 
Page View with View > Page Display > Show Cover in Two Page 
View: this will display the pages in reader’s spreads.

Ream: 500 sheets of a given size of paper.

Reflective art: Art that can only be seen by light reflected off it. Photographs, painting, most 
printed matter are examples of reflective art. For printed pieces this generally uses CMYK. 
See Transmitted art

Registration: Placing two or more images (color separations) over one another in such a way 
that they are exactly align. See misregistration.
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Registration black: A black made from the C100 M100 Y100 K100, that is, 100% of each ink. 
In most printing this is too much ink and other than for registration marks, it is rarely 
used for printing. See TIC.

Registration mark: A graphic device to assist in aligning two or more images (color separations).

CS does not want registration marks on print-ready files.

Rendering intent: Because the RGB gamut is bigger than CMYK’s, those colors that are out-
of-gamut must be dealt with when converting from RGB to CMYK. There are four ICC-
specified approaches: 1) Absolute Colorimetric Rendering—all in-gamut colors are exactly 
converted, while the out-of-gamut are clipped to the nearest reproducible hue. Lightness 
and saturation are lost. This is the standard default. 2) Perceptual Rendering—compresses 
all the RGB colors into the CMYK destination, preserving the overall, perceptual image 
appearance. All the colors, in-gamut and out-of-gamut will change a little. This is usually 
the best intent. 3) Relative Colorimetric Rendering—scales the white of the source file 
to that of the target file (the output media). Then all the colors are mapped to the CMYK 
file, lightness and hue are maintained, but the out-of-gamut colors are clipped to the 
nearest reproducible colors at the expense of saturation. 4) Saturation Rendering—maps 
the fully saturated colors to fully saturated colors in the CMYK, at the expense of hue 
and lightness. This is best suited to charts and logos, where certain colors are intended 
to pop, but specific hues are less important.

Resolution: The degree to which an image or device can record or reproduce detail. Bitmapped 
images, where the image is made up of pixels, will have a certain number of pixels per 
inch (ppi). This is the image’s resolution. Commonly, but incorrectly, it is stated as dpi, 
dots per inch.* A low resolution image would be 72 dpi. A high resolution image would 
be 300dpi, which is what most printers want to work with.

Notice that with the higher resolutions the jaggies are much less apparent.

There are articles saying 300 dpi is unnecessary for printing and that even 72 dpi or 96 
dpi images can work. As general advice, that is baloney. The image on the left is a screen 
print of Chardin’s Laundress, from the Hermitage; and right the same image as it printed.

*	 Throughout this book, I tend to use dpi, sometimes with a reference to ppi, but it is a losing battle. 
An example of when when this misuse becomes important, is when there is some confusion over the 
addressible dots in a printer versus the “dpi” of an image.



5757Registration Black—Right Reading

While images around 200 dpi (see page xx) resolution can work well or sometimes bet-
ter than 300 dpi:

                                             200 dpi                                            300 dpi

Here details from two identical printed pieces, except that the one on the right, the original, 
was printed at its original 300dpi. On the left, the image was saved as a PDF in Word and 
was automatically downsized to 200dpi. In this detail, the 200 dpi image feels sharper. 
Although the overall image may have lost a little, arguably, in this example, at least, 200 
dpi printed as well as its 300 dpi original. Despite this example, 300 dpi images remain 
the standard in the printing industry, and should.

RGB: A color system made up of red, green, and blue light. Typically this 
is the color space your monitor, camera, or scanner. See CMYK.

Right Reading: An image or page of text that reads left to right, top to 
bottom, that is, correctly. Often used to describe the orientation 
of a printed sheet.
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Image Resolution
Resolution is the degree to which an image or device can record or reproduce detail. This is 

commonly stated as dots per inch , dpi, or, more correctly, pixels per inch, ppi. The image dimen-
sions are inversely related to the resolution: if one goes up the other goes down:

Resized without sampling

All three images have the 
same file size, 37.9 KB. At 
0.24" wide the image is 300 
ppi, at 1" wide, it is 72 ppi, and 
at 4" wide, it is 18 ppi.

Except in graphics editing 
programs, when an image is 
resized, this is what happens. 
The image is pixilated.

Resized with sampling

Here, all three images are 
300 ppi at the same dimensions 
as above. However, the file 
sizes are 37.9 KB, 309.4 KB, 
and 4.62 MB, left to right.
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For most printing, 300ppi (most people will say 300 dpi)*is the norm. This is true for ink jet 
and laser jet printers, as well as large, commercial presses, digital or non-digital. Although some 
images might print well at lower resolutions, and some better at higher resolutions, 300 is a safe 
number.

Regardless of whether you work in InDesign, Word, or OpenOffice, resizing the image in-
side the program will usually keep the file size the same and the resolution will change. In some 
programs, such as Word, some people have experienced catastrophic downsizing (for example, 
300ppi > 96ppi). †

Roughly, a digital pocket camera produces a good quality image that is 12" x 9" at 300 ppi, 
but it often opens up in software as 50" x 37.5" at 72 ppi. Reduced to standard print sizes, the 
image quality is perfectly adequate.

This is the basic relationship between image size and resolution with and without sampling 
on. Without sampling, nothing new is invented; and if one increases the other decreases. Whereas, 
with sampling you can control both size and resolution.

As noted above, changing the dimensions and the resolution requires sampling. Graphics 
programs have sophisticated algorithms that sample (also called resampling or interpolation) 
the original file, calculating either new, additional pixels when enlarging, or what to remove and 
how to alter the remaining pixels when reducing, so that the enlarged or reduced images appears 
otherwise unchanged.

Although sampling can produce enlargements as much as 800% from good images, or even 
2,000% from a very high quality image, if the original image does not have enough visual infor-
mation, the interpolation process has nothing to work with. What often confuses people is images 
we see on our monitors.

Personal computers (PC and Mac) are designed to give the best possible online experience, 
which means the monitor, video card, and operating system produce unbelievably good monitor 

* A pixel at 300 ppi printed by a Canon Pixma printer requires 32 x 32 tiny dots of ink (1024 tiny drop-
lets): the Pixma prints at 9600 dpi. In trying to promote “ppi” over “dpi” when talking about resolu-
tion, I know this is probably a losing battle, but for this little information piece, I will persist, but 
understand that most people will say “dpi.”

† Word 2007+ will also “compress” images (downsize) unless the feature is turned off, see page 18.
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images from truly awful web image files. Here, left, is a screen shot of Chardin’s The Laundress. 
The online images was about 3 x 4 inches, and as can be seen, isn’t bad even with enlarged. The 
same images printed shows an entirely different story.

Free programs like Irfanview and GIMP, have sampling. Generally, look under Image > Im-
age Size or Image > Scale. (Canvas size—found under Image—refers to the overall dimension of 
the the image file. A 4 x 5 inch will open as a 4 x 5 image, but the overall size, the canvas could 
be changed, for example to 6 x 7—the image size would not change, but the background would 
be bigger by 1 inch all the way around. )

Note: Starting with a low resolution image, left below, and simply increasing the resolution 
produces a softening of lines and edges, middle. Some images may need to be sharpened, right, 
to bring back crisp edges. (The duck on the first page was not sharpened.)

The biggest exception to the 300 dpi standard is for 1-bit art—that is, line art that is either 
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black or white, with no grays. On the right, the 300 dpi art shows jaggies, because of the alias-
ing caused by relatively low resolution. At 800 or 1200 dpi, the aliasing is gone. Whether 1200 
dpi is truly better than 800 dpi is hard to tell—although I think not—the variations could be 
due to how the dots of ink react to the paper fibers in printing. Some people suggest that 600 
dpi is generally sufficient for 1-bit art.

A second exception to the 300 dpi standard is difficult to define. Some images do not need 
that much resolution. On the next page, there are two identical images printed from 200 dpi 
on the left and 300 dpi on the right. While I prefer the 300 dpi image, the 200 dpi image is 
adequate. See image on next page.

General guidelines for printing images
•	 If images are to be used in print jobs, they should be 300 ppi.
•	 Most monitors are too bright. Images that look good on a bright screen will tend to look 

darker and muddier when printed.
•	 Print images to proof them.*
•	 Size images in graphics programs to the exact size required: do not resize inside any pro-

gram that does not have sampling. Specifications requiring images at 100% mean:
•	 at the size intended to printed
•	 at 300 ppi (dpi)

•	 Insert or place images into files, do not drag and drop or copy and paste.
•	 Cameras, scanners, and monitors are sRGB devices (full color is created by varying amounts 

of Red, Green, and Blue). Most desktop printers are set up to work best from RGB color 
(although their ink-sets are CMYK, Cyan, Magenta, Yellow, Black). Some commercial printers 
(printing in CMYK) prefer images converted to CMYK, some do not. Check with your printer.

•	 All digital images are soft. Most cameras sharpen the images, and make other adjustments. 
(Images that have not been manipulated in the camera are called camera raw.) Check your 
images for sharpness.

* Soft proofing, that is, looking at them on the monitor, requires a calibrated monitor and a good 
color management regime, including ICC profiles for print output devices.
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•	 It is rare for an image to get better when commercially printed. Shadow detail tends to plug 
up and highlight detail tends to blow out. Compensate when adjusting your images for print.
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Reverse/reversed out: To print text or an image in the opposite color (often just paper) to the 
background: this is reversed out.

Rich black: a black made up of all four CMYK colors. Photoshop Black is C75 M68 Y67 K90. 
Rich black has traditionally been a problem especially with type because it requires perfect 
registration

(C0 M0 Y0 K100) (C75 M68 Y67 K90) (C100 M100 Y100 K100)

In black and white printing, K-only should print without screening (unless it’s part of a raster-
ized image); however, any rich black, will be screened and will appear less black.

Right reading: a piece is right reading when it can be viewed correctly, and text goes from top 
to bottom and left to right—that is, when it isn’t upside down or sideways.

RIP: Raster Image Processor. The RIP is the process and means of converting vector information in your 
file (type, for example) and all other image information into a raster, bitmap, file composed of 
dots that can be printed. The process consists of interpretation, rendering, and screening. The 
page is defined and all of the elements that make it up are defined and mapped into a raster 
image. This is where profiles are applied, and adjustments are made for GCR, sharpening, dot 
gain, etc. The page image is then screened, and converted into dots to be printed.

Rule: A continuous line used for alignment, separation of page elements, or underlining; short for 
rule line. The smallest rule is a hairline. A down rule is a vertical rule.

Sampling: This feature of most graphics programs permits enlarging or reducing the size of an 
image while setting the resolution at what you want (also called interpolation or resam-
pling). Without sampling, if the dimensions are changed, the resolution changes inversely. 
With sampling, the program invents new pixels, or removes pixels, adjusting the remain-
ing ones, so that the new size is identical in appearance to the original at the same or any 
preset resolution.

No Sampling Sampling
Dimension Resolution Size Dimension Resolution Size

4 ″x 5″ 300 dpi 5.15 MB 4 ″x 5″ 300 dpi 5.15 MB

8″ x 10″ 150 dpi 5.15 MB 8″ x 10″ 300 dpi 20.6 MB
12″ x 15″ 100 dpi 5.15 MB 12″ x 15″ 300 dpi 46.3 MB

Most graphics programs have sampling, but most word processors and desktop pub-
lishing program do not. If you adjust the size of an image in Word or even InDesign, 
it will not be sampled and the resolution will change.

Safe Zone: is generally an area inside the trim that is safe for text. However, text and images can 
bleed, but parts get trimmed.
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For CS, text and images in the interior must be at least .25” inside 
the trim lines, 0.125” for covers.

Sans serif: Type that does not have a serif: This is sans serif. See serif

Saturation: is the colorfulness of a color compared to its brightness. In this example, the 
top is fully saturated, and the bottom is fully desaturated (grayscale equivalent 
of red). See desaturate.

Screen: The image is separated into four process colors. Each process color is converted into half-
tone dots of varying sizes and angles. See halftone.

Scale: to increase or decrease the size of an image while maintaining the original proportions.

Scanner: is a device that takes accurate pictures of documents. Scanning is one of three ways to 
create digital images: digital photographs, scans, and digital painting and drawing.

Screen angles: the angles screens are placed to avoid Moiré patterns, see example under halftone. .

Screen font: is a font that is intended to look and work best on a monitor. Postscript fonts have two 
components, one is best for printing and the other is best for display.

Screen frequency: is usually given as lines per inch, lpi, although this is usually the same as the 
dots per inch.

Secondary Color: is a color made by mixing two primary colors within a specific color space. In 
RGB, the secondary colors are cyan, magenta and yellow; in CMY, the secondary colors 
are red, green and blue.

Selection: is the isolation of a part of an image. Graphics programs have many selection tools—
magic wand (selects by color), polygonal tool, pen tool, etc. And selection can be saved, 
depending on the program, as selections, paths or in channels,

In the example below, the flower has been selected, which appears as a moving dashed line, 
called marching ant. What is outside the selection cannot be altered. However the selection 
can be inverted: the top right selection was inverted and the background darkened.
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In these examples, the flower selection was moved to its own layer with black behind it, 
left, and right, on white, it was rotated and enlarged.

Separations: these are the separate color carries that, when combined, create a full color image. 
For most printing, these are cyan, magenta, yellow, and black. These can be made in film 
and plates, or digitally. See examples on pages 31 and 49.

Serif type: is type that has serifs, i.e. little extensions from the main strokes of a character: This 
type is serif type. See sans serif.

Set-off: the unintentional transfer of printing to the sheet it is in contact with.

Shade—is a mixture of the color plus some amount of black. See Hue.

Shadow: the darkest neutral areas of an image.

Shadow values: the darkest values that still show detail.

Sharpening: a technique for bringing out detail in an image. It does it by increasing the contrast of 
transition areas: the edges of the lighter areas get lighter while the edges of the darker areas 
get darker. Because all digital images are soft when they are first created, most images are 
sharpened either in the camera or scanner or manually in a graphics program. Excessive 
sharpening produces halos.

Graphics programs usually offer many ways to sharpen images.

                                 Normal E                                                    xcessively Sharpened
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                                          Blurred                                       The Blurred Image Sharpened
Just to show the relationship between blurring and sharpening, the Normal image was blurred 
(softened) then it was sharpened, note that most of the detail was recreated although both 
blur and sharpen are destructive processes: that is, they destroy or permanently alter pixels.

Sheet-fed press: a printing press that uses pre-cut paper, instead of a single sheet in a roll. See 
web press

Show-through: is the amount of printing on the reverse side that visible under normal viewing 
conditions.

Signature: is a folded sheet that forms the pages of a book. Folded once, a signature contains 
four pages, folded twice, it has 8 pages, etc. In preparation of binding, the signatures are 
gathered in order. [Printing with CS, we really need only think of working with two-page 
“signatures.”]

Simultaneous Contrast: any change in the appearance of a color relative to either a background 
color or to adjacent colors. This is the Munker illusion:

There are three colors: blue C88 M77 Y0 K0, yellow C6 M0 Y96 K0, and green C83 M6 
Y 95 K1. There are no other colors. (The illusion works in grayscale as well.)
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Related to this, are temporal and spacial considerations. Colors can appear to change be-
cause we’ve stared at them for a while, or change distances.

The point is that while a spectrophotometer will see only three colors, the human eye sees 
four. So the context of a color is important, after all, we are printing for other people to 
see, not for measuring equipment.

Soft proof: a digital proof seen on screen instead of on paper. It is intended to simulate color space, 
inks, paper, profiles, etc. To be accurate it requires correct calibration, the correct ambient 
light, and the correct profiles. [With CS, we do not know what profiles to use.]

Specular light: highlights that reflect light directly, it generally has no dot or tonality.

Spine: the back of a book that connect the two covers, which to say, also, where the pages are hinged.

Spine—text: See spine titling. [Every book will vary slightly when bound. “Allow for 0.0625" 
variance on either side of the fold lines for your cover. For example, if your spine width is 
1", your text should be no wider than 0.875". Because of this variance, avoid hard edges 
or lines that end on the fold line. For books with a page count of less than 130 pages, we 
strongly recommend a blank spine. Blank spines are required for books with a page count 
of fewer than 100 pages,” CS guidelines.]

Spine titling: in the US and UK the correct orientation is so that when the book is placed flat on a 
table with the front cover up, text on the spine reads correctly left to right.

Spine width: The spine width is based on the number of pages in your books multiplied by a factor. 
For CS, multiply the page count by 0.002252" for white paper (B&W books only); 0.0025" 
for cream paper (B&W books only); 0.002347" for color books only.

Spot color: or control color, is a premixed ink so that it can be printed solid or screened, but it is 
not made up of process colors.

Spread: two facing pages in a publication.

sRGB: is the standard RGB color space. It was created for monitors, printers, and the Internet. 
Therefore most cameras and scanners use sRGB as the default or only color space.

Step wedge: A gradient broken into steps, used for reference. Here is a common step wedge in 5% 
increments from black to white. Related to the step wedge is the color spectrum ramp (or 
wedge:

Stitching Line: is a very thin black or white line that appears in a PDF that are associated with trans-
parency and flattening—specifically with atomic and complexity regions. See transparency.

Stochastic screening: this is one of several non-conventional screening (halftone) methods. Sto-
chastic screening separates the image using a very fine, seemingly random, dot.
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Stock: the type of paper or other substrate that a particular job is being printed on.

Subpixel rendering: is a way to increase the apparent resolution of LED or LCD displays. Because 
each pixel is made up of three and sometimes four pixel components, or subpixels (red, 
green, and blue, and sometimes yellow), these can be used, just as gray tones are used in 
anti-aliasing.

Subtractive: is the color model for reflective art, as opposed to transmitted 
(like monitors). The color you see is caused by the the material ab-
sorbing the colors it is not (subtracting from the light) and reflecting 
what color it is. Using CMYK halftone dots and the yellow rose on 
the opposite page, the yellow dots are absorbing the cyan and magenta 
light components and reflecting yellow. See additive, RGB.

Substrate: the material being printed on.

Surprint: to print over something that has already been printed. Same as overprint.

SWOP: Standard for Web Offset Printing.

Tablet: is an input device, used for drawing and writing. It has two parts, the tablet for draw-
ing on, and pen-like device or stylus to draw with. Graphics tablets permit control over 
light/dark, thick/thin when painting lines, as well as mouse-like controls.

Tack: is how sticky ink is. Generally, in offset printing, the ink must be sticky enough to adhere 
to the paper, but not so sticky as to lift the paper or tear it.

Tagged: is another way of saying a file has an embedded color profile. A tagged image means 
the same as an image with an embedded profile, ICC profile, color space, etc. Embedding or tag-
ging enables an output device such as a monitor or printer to display the color correctly.

Targeted correction: in digital image enhancement, a targeted correction is one made to spe-
cific areas of an image, not made globally. This is done either by creating selections or 
by using painting tools, which include the eraser, clone tool, paint brush, dodging, burn-
ing, smudge and sharpen tools.

Text figures: see non-lining

Text paper: is a paper suited to good printing, more opaque than bond paper, finished two sides 
with good folding and durability qualities. Also called book or offset paper.

Three quarter tone: tonalities of an image that lie between the midtones and the shadows.

TIC/TAC: Total Ink Coverage (Total Area Coverage) refers to the total amount of ink or toner 
that can be put on paper. Each ink can be applied between 0-100%. (If each ink were 
printed at 100%, that would be 400% TIC. The upper limit varies according to the print-
ing process, the speed of printing/drying times, the inks, and the paper. Over inking is 
also referred to as paper wetness, it can result in offset, ink not sticking, etc.
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Web offset 240-260%
SWOP:300% (e.g. Photoshop black, C75 M68 C67 K 90 = 300%)
Sheetfed offset on coated paper 320-340%

Note: Since I was apparently able to print Registration Black 
(C100 M100, Y100, K100), which is 400%, TIC is not a sig-
nificant problem with CS; however, Lightning Source recom-
mends a maximum of 240%, well below PhotoShop default 
black (300%).

TIFF: is an image format, Tagged Image File Format, or tif. Although TIFF files are usually 
large, they can be compressed. TIFF uses lossless compression (except when JPG com-
pression is chosen).

Tint: is a mixture of the color plus some amount of white. See Hue.

Title and Author: Your book’s title and the author’s name must appear on the cover exactly as 
it was entered during the title setup process.

Tonal range: is the difference between the darkest and lightest tones in an image.

Top Bind: applying the binding to the top edge of the book rather than the side. This can be done 
with prior notification of CS Customer Support. See Landscape

Transparency: transparency refers to objects or text that appear transparent, that is, they let objects 
that are underneath them show through. Generally this means having layers. Converting 
all images to JPGs removes transparency. PDF/X and PDF/A remove transparency, see 
Flattening. The problem with transparency is that objects beneath transparent objects, 
or even very close, can be adversely effected (stitching lines, color shifts,etc.). The PDF 
output (monitor/printer) is independent of the software or hardware used to create the 
original page or images, and must deal with layers, stacking order and transparency. 
Because PDFs are what most digital presses print from, and Adobe is at the forefront of 
these things, most of the following involves Adobe products and adobe solutions.

See Layers for the most common cause of having issues with transparency.
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Transparency
Transparency refers to objects or text that appear transparent, that is, they let objects that 

are underneath them show through. Generally this means having layers. Converting all images 
to JPGs removes transparency. PDF/X and PDF/A remove transparency, see Flattening. The 
problem with transparency is that objects beneath transparent objects, or even very close, can 
be adversely effected (stitching lines, color shifts,etc.). The PDF output (monitor/printer) is 
independent of the software or hardware used to create the original page or images, and must 
deal with layers, stacking order and transparency. Because PDFs are what most digital presses 
print from, and Adobe is at the forefront of these things, most of the following involves Adobe 
products and adobe solutions.

Left: this image contains several examples of transparency. Each element is on it’s own layer. 
The checkerboard background indicates transparency. Each layer has transparency. The text, 
vector art, requires transparency. The drop shadow requires transparency. Right: combining all 
the visible layers into one layer, flattening, removes the transparency; although there still could 
be an alpha channel if that’s supported in the file format.

To simplify handling transparency, pages are divided into atomic regions and the transpar-
ency effects are resolved for each separate atomic region, then stitched together. PDF’s can con-
tain transparent objects with different color spaces, for example: a spot color with a drop shadow 
over a CMYK background, or a translucent RGB image over a CMYK background. These an 
result in color shifts, sometimes only in part of an image. The interaction of text or other vector 
based objects and a bitmapped (raster) oject can result in some part of the vector object being 
converted to bitmap (with text, some part may look thicker). Sometimes, multiple layers that 
contain transparency can create problem when determining which parts combine with which.

Transparency comes from:
•	 Making an object transparent: for example, removing the background, or placing an object 

on a transparent layer (the file format/application must support transparency)
•	 Adding a drop shadow or feathering, blending modes or opacity
•	 Layers
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•	 Editable text requires its own layer
•	 Placing files with transparency into the document
•	 To remove or prevent transparency:
•	 PDF 1.3 do not support transparency (PDF 1.4+ can, which enables keeping text in an edit-

able form. )
•	 PDF/X, PDF/A, and Print Quality (in Acrobat) do not support transparency
•	 JPGs, for example, do not support transparency

There is a vocabulary related to transparency (note: many of these definitions relate to Ado-
be programs; non-Adobe PDF conversion programs might have different names):

Alpha channel: a channel that contains transparency information.

Atomic regions: 1) the smallest intersections of objects related to transparency; 2) zones a page 
is divided into when it is flattened. Objects (text, vector, image) may be divided among 
atomic regions.

Blending mode: a specification for various ways in which the colors of object above or beneath 
each other can blend:

The blue panel was placed over the flower pictures, then blending modes were applied 
to the blue layer. A: normal, that is, no blending. B: the opacity of the blue was reduced 
to 50%. C: blue was set to multiply, which multiplies the pixel values underneath it. 
D: color burn divides the inverted bottom layer by the top layer then inverts the result. 
E: difference subtracts the bottom for the top or the top from the bottom —whichever 
produces a positive value. F: blend if (red, normal mode at 60%)permits a particular 
blending mode if the values of one layer, above or below, is darker or lighter, red, green, 
blue, or luminance. Including Normal, InDesign has 16 blending modes and Photoshop 
has 27, each can be effected by the opacity slider, which itself is creating transparency.
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Clip: is to cut. Specifically here, it means to use a vector object as a mask or window for other 
objects, see mask. While raster objects can be used this way, they leave rougher edges 
than vector shapes that work at the resolution of the output device.

Clip Complex Regions: is a Transparency Flattener option. It places the boundaries between 
vector and rasterized art fall along object paths, which reduces stitching artifacts (where 
part of an object is rasterized while another part remains vector).

Color stitching: is a visible difference in color between objects whose color should be identi-
cal—most commonly caused when only a portion of a vector object is rasterized.

Complexity region: is an area that because of a complex transparency interaction, is rasterized.

Convert All Strokes to Outlines: is a Transparency Flattener option. It converts all strokes 
to filled paths, ensuring that the width of strokes is consistent during flattening. Thin 
strokes may appear slightly thicker.

Convert All Text to Outlines: is a Transparency Flattener option. It converts all text objects to 
outlines and discard glyph information. It ensures that text width is consistent during 
flattening. Small text might appear slightly thicker.

CT/LW: (continuous tone/line work) are two file formats—dual resolution—used by Scitex.

Drop shadow: is a live effect that can be applied to objects or type in Illustrator, InDesign, 
and Photoshop. Generally it is a shadow that appears under an object from a specific 
direction. The drop shadow is a source of transparency and in Adobe products requires 
the Transparency Flattener to process it (in the example, the images were converted to 
JPGs, which removed the transparency).

Dual resolution RIP: is a RIP where each pages is created in a unscreened, intermediate, rat-
sterized format in two files: a high resolution file for line work and text and a lower 
resolution file for continuous tone images.

Fatten: is the process of creating high resolution image data from low resolution image data or 
place holders. See OpenPress Interface.

Feather: is a live effect that vignettes the edges of an object. It requires Transparency Flattener 
to process it. See vignette. (In this example—prior to feathering, it was basically the 
same as the drop shadow, less the drop shadow—the images were converted to JPG, 
which removed the transparency.) Example on next page.
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Flattener presets: are Low Resolution, Medium Resolution, and High Resolution in Transpar-
ency Flattener. Custom presets can be created.

Gradient and Mesh Resolution: is a Transparency Flattener setting that sets the resolution ap-
plied to any gradient meshes and gradients that are involved in transparency.

Gradient mesh: is a single, multicolored Illustrator object on which color flows smoothing with 
seamless transition.

Gradient: is a fill or stroke containing a smooth blend of color(s).

Ink Manager: is an Indesign feature that lets the user control the output of each color in a docu-
ment.

Interacts with transparency: is describes objects that may not be transparent but which could 
be affected by the Transparency Flattener during flattening.

Line Art and Text Resolution: is a Transparency Flattener setting that sets the resolution for 
complex areas that need to be rasterized. Typically, this should match the resolution of 
the output device.

Live effects: are Illustrator operations (also in InDesign effects, and in Photoshop as effects and 
styles) which can be edited. These include drop shadow, feather, inner and outer glows, 
etc., which make an object a source of transparency.

Live transparency: is any transparency effect that is live—that is, it can be edited. Once the 
effect has been flattened or rasterized it is no longer live.

Opaque: is the color attribute of being impenetrable to light, non-transparent, non-translucent. 
An opaque object totally obscures anything beneath.

Open Press Interface (OPI): is an standard whereby you can use low-resolution images in your 
page layout, but they are replaced by high-resolution ones by a RIP or OPI server. The 
proxy images must not interact with transparency or they could be processed into the 
output by the Transparency Flattener.

Overprint Preview: is a display option in Illustrator, InDesign and Acrobat 8+ Professional 
that shows the effects of object overprinting. It lets you view flattened output more ac-
curately.

Pages panel: is the InDesign panel that shows pages and spreads in small icons. If the page 
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contains transparency, the background in the pages panel page icon will show a check-
erboard background.

Proxy image: is a low-resolution placeholder image. See Open Press Interface.

Raster/Vector Balance: is a Transparency Flattener setting. It lets the user set the amount of 
rasterization. The lower the setting the more will be rasterized; the higher the setting the 
less rasterization is done to the document.

Seam stitching: is the appearance of white or black lines in a flattened images or difference 
along the borders of atomic or complexity regions. Although Adobe says the white lines 
are non-printing—enlarge the image, if the white line disappears it is non-printing; 
black lines print—there have been reports (anecdotal) of white stitching lines printing.

Separations Preview panel (Window > Output > Separations Preview) shows the color separa-
tions individually or in combination. It includes a dynamic densitometer that displays 
separation values where the cursor is positioned.

Source of transparency: is any object with less than 100% opacity, blending mode other than 
normal, drop shadow, or feather.

Stacking order: is the back-to-front or front-to-back order of objects on a page, within and be-
tween layers. Objects beneath transparent objects may be affected during transparency 
flattening.

Stitching lines: are black or white lines along the boundaries of atomic regions. Adobe says 
that white lines are most often non-printing (by enlarging an image, those lines should 
disappear or remain exactly the same size), and black lines will probably print. Several 
website say that white stitching lines may print. See clip complex regions.

Adobe has a page on how to deal with these lines (http://helpx.adobe.com/indesign/
kb/thin-white-dark-lines-stitching.html). Depending on the cause, some people recom-
mend using a PDF setting that preserves live transparency, and when that is the solution, 
PDF/X-1a will not work. However, I’ve encountered lines where using PDF/X-1a does 
eliminate them.
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Sometimes these lines are not stitching lines, but are lines that come from the art itself, 
not the PDF conversion.: working in layers and having an edge of a selection print, as if 
it were stroked. The solution is to go back to the art and erase the offending line(s), or, 
if the image has been flattened, paint it out.

Transparency Blend Space: sets either RGB or CMYK as the color space in which Transpar-
ency Flattener works. It tells the Flattener what profile to use for various transparent 
objects of different color spaces.

Transparency Flattener: is a component of Illustrator, Indesign and Acrobat 8+ Pro that pro-
cesses live transparency along with the objects it interacts. It creates a an opaque object 
that has the appearance of the original, but which can be rendered as PostScript. It is 
available for the PDF/X preset.

Transparency interaction: is the relationship and affect between a source of transparency and 
any other object that is a source of transparency or is very close, generally a point, to a 
source of transparency.

White: as a color in images is opaque. It hides what is beneath it. Generally, if a white object 
hides text or part of another image, that is how it will print, as if it were opaque, and 
what you will see is paper color. However, if you print an image on a white background, 
the white will be non-printing—as if it were transparent; if the paper has pre-existing 
text the white areas of the image would not hide it.

Working with CS

CS will accept images with transparency, but they will give a warning in their review letters, 
saying that this could cause a shift in color. When images are flattened there is often a slight shift 
in color—this occurs in Photoshop, for example, all the time, although most people never notice 
it. If there is transparency, you could do one of two things: ignore the warning and proceed, 
knowing that you could end up with a color shift that is unpleasant (I have never seen this); or, 
fix the transparency.

As a matter of workflow, it is often best to eliminate transparency whenever possible, just 
to avoid problems.

This is a related prob-
lem: how the RIP handles 
transparency and screening. 
This is part of a test print-
ing text in Photoshop Black 
(four-color), and K-only. 
Because of registration prob-
lems, you can see a strange
manifestation: the rainbow “t” which should have been K-only, but printed in what is regis-
tration black with no screening. Eliminating transparency would not have prevented this, but 
strange things happen with transparency as this shows.
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Trapping: overlapping adjacent colors slightly to hide possible registration problems. 
Here, TRAP is to be printed in the color on the left. A is the ideal. B, however, shows 
what happens if the word is simply printed over the red, the blue changes. So, as in A, 
the word TRAP is knocked out of the red and then printed over the white. C shows what 
happens if the registration is off: while the slightly redder fringe is barely noticeable, the 
exposed white is unacceptable. To prevent the effects of misregistration, the word can 
be trapped, either by reducing the size of the white knockout, as in D, or the blue could 
be enlarged (not shown). These examples have been exaggerated. No trapping was used 
in this book.

Sometimes the cure is worse than the problem. For CS, trap-
ping appears to be unnecessary.

Trim: is to cut excess paper away after it has been printed, folded, gathered, and bound.

Trim mark: is a mark on the printed piece to indicate where the trim should occur. It is not used 
with CS: that is, PDFs are not to have them.

Trim Size: is the size of the piece after trimming. For example, this is the final size of your book 
in width by height, for example 6 x 9. (Note, customarily the width comes first.) On a 
template it is shown as the trim line. It is synonymous with paper size when working in 
word processing, publishing, and PDF conversion program.

Trim zone: a margin, no less than 0.125" on one or more sides of a image that will be trimmed 
off in binding. It starts at the trim line and goes out away from the edge.

True type: see type

Two up: to impose two items (generally pages) on a press sheet.

Type: is the small block of wood or metal, or the digital equivalent, of a letter or character used 
in printing. With the advent of desktop computers, the terminology is now imprecise. 
Font is a complete set of characters (uppercase, lowercase, numerals, punctuation, etc.) 
for style or type effect (regular, italic, bold italic, etc.) in one family: for example, Times 
New Roman regular; whereas Times New Roman italic is a separate font. Typeface is 
correctly synonymous with type family: a set of related fonts, designated by names: 
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Times New Roman, Arial, Garamond, etc. Each font on a computer is represented by a 
font icon, or in a font folder; however, word processors are able to create imitation fonts, 
see Faux Fonts, which do not print reliable if at all in the context of print-on-demand 
printing.

In considering a typeface or font, we look at the various parts of each letter:

Alphabet/Type Image]

Fonts come in three basic formats: TrueType, OpenType, and PostScript fonts. Several 
questions persist: which formats are cross-platform (Mac vs. PC), which formats dis-
play well, and which formats print well. Macs since OSX (some sources say 7.x*), and 
WIndows since Window 2000, that is roughly any computer built since 2000-2002 can 
use True Type, Open Type, and Postscript fonts.

Before Windows 2000, PostScript fonts would only work in PC’s with Adobe Type 
Manager. PostScript was the preferred font for Apple computers and the font of choice 
for graphic designers for years, and the bias persists. TrueType was developed jointly by 
Windows and Apple. However, it is associated more with Windows.

TrueType and Postscript fonts can contain 256 characters, OpenType, based on Tru-
eType, can have 65,000+ characters.

TrueType, OpenType, and PostScript fonts are scalable, vector fonts. There is a bitmapped 
font format where each font, like metal fonts, is one style from one family in one size.

UCR: under color removal is the process of removing CMY that added to dark neutral blacks to 
avoid exceeding a specific TIC.

Uncoated: paper that has no coating. These are not as good for halftone printing as coated pa-
pers. See coated.

Unique Hue: there are four unique hues in the opponent process theory, red, yellow, green, and blue.

Unsharp masking: is a sharpening technique that combines a blurred inverted (as in: postive/
negative, negative/positive) with the original in registration, increasing the accutance 
(edge contrast). With film, it is literally an unsharp mask: the mask is a second piece of 
film that is slightly out of focus (this is usually done by exposing a second piece of film 
base side to base side, like a contact print, except that because of the gap caused by the 
film base, it is soft.). In the example below, done digitally, and inversion of the original 

* http://www.microsoft.com/typography/WhatIsTrueType.mspx
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was made and it was softened. To show how this works, both the original and the soft 
inverted images were aligned and a blending mode (Linear Burn) was applied, which 
shows the edge effect:

Unwanted color: the weak ink when two other colors are dominant. The unwanted color can 
be used to improve contrast. In the example below, the original is on the right, the im-
proved image on the left. It was not sharpened, rather the yellow and black channels 
were adjusted.

                                        Improved                                                      Original

Vector: this is a type of computer graphic that uses points, lines, and curves to describe an image 
mathematically. Unlike raster graphics where the file size is proportional to the images size 
(bigger image—bigger file size; smaller image—smaller file size); vector art is “infinitely”
scalable. The file size does not change if you 
want a bigger or smaller image. Type is vector.

Vignette or vignetting: often called feathering, is 
basically a gradient applied to the edge of an 
image or shape. The image on the right has 
been vignetted. When applied to a shape or 
selection, it is called feathering.
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Watermark: 1) a mark impressed in the paper when it is made; 2) a lightly printed mark often 
used to indicate proof copies or prevent copying. Web press: a high speed offset press 
that prints paper from a continuous roll.

Weight: the density (weight) of specific paper in a specific size, measured in pounds.

White point: is the place in an image that is or should be white, that is with no color cast. I tis 
used in image capture, enhancement, and reproduction.

Widow: is the last line of paragraph that begins a page; an orphan is 1) a very short last line of a 
paragraph, generally a word or part of a word, or 2) the opening line of a paragraph that 
appears as the last line of a page.

In books I examined, written and designed by Hermann Zapf, Bruce Rogers, Frederic 
Goudy, Adrian Wilson, and books designed for limited edition publishers like The Folio 
Society or The Heritage Press, none contain widows, and all contain orphans—with 
either meaning.

Widow/Orphan control produces long and short pages—vertically unjustified—which 
is never done by good book designers except as the only remedy to a difficult formatting 
problem and then only when both pages of a spread are either long or short (almost all 
spreads made up of the last page of a chapter and the opening page of the next will each 
have a different number of lines).

Wrong reading: An image or text that is flipped so that it does not read top to bottom, left to 
right—for example, holding a book sideways, or printing a page upside down.

WYSISWG: what you see is what you get. This is the promise of most word processors, graph-
ics programs, and PDFs. Usually it works, sometimes it does not.

X-height: see Type


